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Section 4 Tables
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.
By the end of this section you will be able to
•

Build tables

•

Set field properties

•

Set primary key

•

Create lookup fields

•

Relate tables

•

Manage data within tables

•

Format and set defaults for tables

Creating Tables
In this lesson we will learn much more about the usage of tables, including how to build them from scratch. You now
should be familiar with the views and the terminology within access. W weshould have our database all planned out.

About Tables
You should be very familiar with the components of tables by now. We know a table is made up of several records each
containing fields with data. Access also makes it easy to build and modify any component of a table using Design view,
which we will cover later in this manual.
When designing a database, it is critical that you take the time to design your database carefully. Although it is not a
difficult job to make some adjustments to a field, adding or removing fields in a large established database can be a real
headache. It is important to communicate with everyone who will be using the database to make sure that everyone has
the information they will need. Don’t be afraid to build a database a little bigger than you think it needs to be; if you end
up with unused fields they are much easier to take out than to put new fields in.

Create An Empty Table

Access gives you the ability to create a table in a few different ways: opening an empty table and inputting values, using
a template, or using Design view to construct your table by hand.
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Use the Tables section of the Create ribbon to make a table:

ӹӹ To create an empty table
mouse

1. Click the Table command to open a new empty table A new tab will open, containing an empty table in
Datasheet view:
2. Click inside the Add New Field column and start entering data.
3. Press Enteror Tabto keep adding fields to the record, or click In the “new” row to make a new record.
Once all fields are entered for the first record tab and enter will move you through the record and then
onto a new record. Not creating any more fields unless you click in the addnew field column

4. At the Top of the column where it says field1, field2 etc, double click to enter a field name and press return
to enter that name.
5. In the add & delete group on the fields ribbon (table tools) select the format of a field whether a
specific field is to hold textual or numerical data etc.
6. When you have entered some field names and data types click on save to save the table a dialogue will
appear.
7. Enter a name for your table and click ok

Create A Table In Design View
Creating a table in design view needs the most understanding of the construction of a table and access does the least to
help you, but this is the opportunity if you have enough knowledge to create a table and set options that gives you the
most flexibility in constructing your table exactly how you want it.
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ӹӹ To create in design view
mouse
1. Click the Table Design command on the createribbon to open a new blank table in design view. A
new section of Access we have yet to explore will appear:
2. Design view includes its own Design ribbon in a contextual tab. You have the ability to add a primary
key, construct custom formulas, insert or delete different fields, and more.
3. Using Design view is more in-depth than simply entering data into fields. You can specify the field
name, its data type, and give the field some sort of description if you like.

4. At the bottom of Design view is the Field Properties section. Here you can modify all of the
properties of a particular field.
E.G. if you want to have a Price field in your database:
5. Give the field a Field name.
6. Choose a data type for the field.
•

A data type can be a word, number, currency, date, time, etc.

•

The properties of the Price field (once defined as a number) include how large a price it can be, the number of
decimal places, if the field should contain a default value (like $5.99), and more. As we use tables more we will
explore more of the details regarding Field Properties.
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7. When you have entered some field names and data types click on save to save the table a dialogue will
appear.

8. Enter a name for your table and click ok
9. Change the view to datasheet view and you are ready to enter records.
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Adding Field Descriptions
The Field Description fields are located on the right side of Table Design view. The fields are optional, though they
are useful when several people are involved in constructing a database. You can leave a note explaining a field’s function
or why a certain field exists. Anything written here is also displayed in the Status Bar of a form (we will explore forms
later in this manual):
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You can type whatever you like in a field description, just as long as the description is less than 255 characters.

Setting Data Types
Setting a Data Type for a field is a very important first step in creating your database to holding the data you want in
the correct format. Think of each field as a box holding a very specific type of thing not all of your data will be textual.
It may be numerical it may be dates, it may even be a picture or a file. Setting a Data Type helps to ensure that the data
entered follows certain rules
For example
Numbers can be calculated with adding, subtracting etc like in excel. Text can be joined together (text strings) yes/no to
be able to use check boxes etc.
When you were planning your database thought should have been given to what type of data would be held in which field.
After the initial creation of a table and setting your field descriptions we must now ensure the Data Types are set correctly.

ӹӹ To set a Data Type
mouse
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1. Create or open a table in design view
2. Select a field in the topmost part of the design window
3. Use the combo box in the Data Type column to choose a Data Type for the respective field.
4. When all Data Types have been selected save the table return to datasheet view to enter data.

Rename A Field
When you add a field by entering data in Datasheet view, Access automatically assigns a generic name to the field. Access
assigns the name Field1 to the first new field, Field2 to the second new field, and so on. By default, a field’s name is used
as its label wherever the field is displayed, such as a column heading on a datasheet. Renaming fields so that they have
more descriptive names helps make them easier to use when you view or edit records.

ӹӹ To rename a field
mouse
1. Right-click the heading of the field that you want to rename (for example, Field1).
2. On the shortcut menu, click Rename Column.
3. Enter the new name in the field heading.
•

Field names can consist of up to 64 characters (letters or numbers), including spaces.

Adding Captions
The Caption field property is available to every data type available to Access. You can specify a caption to be a customized
label for a field when the field is used in a form or report. You can name a caption whatever you like, or leave the field
name as the default caption name.

ӹӹ To add a caption
mouse
1. Open or create table in design view
2. Enter a field name that will be used in the database.
3. In the properties section in the caption box enter a more user friendly name that users will
understand more readily as a field heading
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Convention and practicallity show that field names are best kept short, to the point and preferably have no
spaces (this helps in calculations) capitalisation of each word in the field name makes for easier remembering
and reading, The caption is only a label and can be whatever you wish it is what the users will see.

E.G.A last name field would be written LastName but the caption could read “Last name” or “Customer surname” as long
as the users would understand

Inserting, Deleting, And Moving Fields
Let’s continue with our vehicle database example. Access lets you easily insert new fields, delete useless/unused fields or
fields that are not relevant to the data, and move the order of fields in a table. The easiest way to perform these tasks is
by using the table Design view.
In this example, we will add two more rows to the vehicle table: Engine type and Colour.

ӹӹ To insert a new field.
either

1. Click in the empty cell beneath the last row in Design view and enter the data
or
1. insert a row between two existing rows. by right-clicking the Manufacture Date field and choose
Insert Rows:
2. This will create a new row between Model and Manufacture Date:
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3. Type Engine Type for the field name and Text as the Data Type.
4. To insert the Colour field beneath Manufacture Date, simply click in the next empty cell in the Field
Name column and type Colour as the name; and Text as the data type:

ӹӹ To delete a row,
First make sure that you remove any dependencies or relationships that may exist with other database objects. Access
can help you with this task, but to be on the safe side, you should first make a backup copy of the database or the table
by using the Save As command.
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mouse
1. Right-click on the blue box beside the field name and click Delete rows

ӹӹ To move a field,
mouse
1. Click the blue box beside the field you want to move to highlight the row.
2. Click the field again, hold down the left mouse button and then drag the field up or down through the rows
of Design view.

3. You will see a bold black line between the various fields as you move:
4. When the black line is in the location you want to move the row, release the mouse button.

Selecting Data
You can select any or all adjacent fields/columns/records in a table at once.

ӹӹ To select an entire table of data,
mouse
1. Open a table in Datasheet view and press Ctrl + A on your keyboard.
Or,
1. Click the Table Selector button (located in the upper left-hand corner or Datasheet view) to perform the
same action:

Download free eBooks at bookboon.com

19

Access 2010: Part II

Tables

ӹӹ To select two or more adjacent records,
mouse

1. Click the box to the immediate left of a record to highlight it:
2. Press and hold the Shift key on your keyboard and click the box beside another record in the table. All
records in between will be selected, including the record you clicked:
3. To select two or more adjacent columns, move your mouse over a column header. Your cursor will become a
small down arrow; click and hold the left mouse button and drag left or right to highlight as many columns
as you want:

4. Finally, you can also select any range of adjacent cells inside a column of data. For example, if we want to
highlight all the fields from the Product ID of Northwind Traders Chai to the Standard Cost of Northwind
Traders Beer:
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5. First, click inside the field for the Chai Product Code, as shown above. Move your mouse to the bottom or
right border of the highlighted field; your mouse cursor will turn into a thick cross. Then, click and drag
from the highlighted field to the last field you want to select:
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Cutting, Copying, And Pasting Data
Once you have selected the data you want, you can easily copy data for use elsewhere and paste data into the table.

ӹӹ To copy highlighted data from a table,
mouse

1. Right-click the data you have selected
2. Click copy:
This saves a copy of the highlighted data in the clipboard of your PC. Once data has been copied, it can be used in a word
processor, a spreadsheet, or some other program that uses text and numerical data.
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ӹӹ To paste the data in the clipboard to another program
1. you can click Paste from the clipboard group on the home ribbon
or
2. edit - Paste- using the menu of the other program.
or
3. Most programs also feature some sort of right-click functionality; right-click your mouse where you want to
the data to go and
4. Click Paste.
5. To paste data into a table is a bit more complicated. You will need to make sure that your source data does
not have the same primary key as any record currently in your table. If you do, Access will prompt you with
an error saying that a duplicate primary key has been detected in the table. You must assign a new primary
key to the pasted record(s) in order to continue. To perform the paste operation, copy the data from the
source program and paste it into the Datasheet view of a table by right-clicking inside the upper-leftmost cell
you want to place the data Paste.
Cutting data in Access requires care if the table you are cutting the data from is related to many other tables in the database.
Cutting data from a table has the same effect as deleting data; that is, it no longer exists in the source table. Therefore, if
there are other tables in the database that rely on the information you are potentially removing, you will need to remove
the relationship between the two tables first. Cutting data has the same sort of effect as copying data; it is stored on the
clipboard of your PC until you paste it into another program.

Primary Key
If you are worked with Access in earlier versions, chances are you have been using the Table Wizard to help construct
tables. One of the nice things about the Wizard is that it can automatically define a primary key for you. The Wizard is
great for getting going, but once you become more comfortable with databases in general, you will likely build all of your
tables using Design view. There is no table wizard in 2010.
A primary Key is a very important Part of a table it allows you to uniquely identify a specific record with an alphanumeric
string (mixture of letters and numbers) that cannot be repeated within that table this can in turn be used within your
database to refer to that record of data without repeating all the field information within that record.
Think of it like this we give a customer a Unique identifier (primary key value) of say BX21 this refers to a specific person.
The rest of the fields in the table would hold that customers information: address, fullname, tel no Age etc. Instead of
repeating this information again later on when utilising customer information we only need refer to the unique identifier
value for the database to pull up and use the rest of the information.
We will look at this more later on as the importance of the Primary key is of the highest level. We look now at just having
the ability to create one within our table.
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Create A Primary Key In A New Table
In previous versions of Access,(2000 – 2003) a primary key was not automatically defined when creating a table in Design
view. This was altered in 2007 where a key was automatically generated when creating a table in design view. When
constructing a table in Design view using Access 2010, this is much the same as in in 2000 - 2003: You are now prompted
when you are ready to close and save the table if a key has not been created manually by yourself

ӹӹ To create key in new table
mouse
1. Create a table in design view as previously explained
2. Enter a field name and add the text “ID” to easily identify the field.

3. For ease at this point set the Data Type to autonumber (this will automatically add numbers to records in a
sequence and not repeat any.
4. Ensure you are in the field you wish to use as the ID field and click on the Primary Key button on the
Design ribbon. In the tools group.
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5. A small key icon should appear next to the field name.
6. Also in the properties section below where it says Indexed it should now read to the right of that
“yes, no duplicates ”

Add A Primary Key To An Existing Table

ӹӹ To add a new field and set it as the primary key
mouse

.
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1. However, consider the following table which does not contain a primary key:

2. Currently this table does not have a primary key. If you recall, a primary key is used as some sort of unique
identifier that separates every row in the table from every other. We need to enter a new field name it and
set it as primary key
3. click within the first row (customer name)
4. On the ribbon in the tools group click on the insert rows button

5. In the row that appears give it a name and set the Data Type to autonumber

6. Ensure you are in the field you wish to use as the ID field and click on the Primary Key button on the
Design ribbon. In the tools group.
7. Primary keys in tables are denoted by a small key in the blue box beside the cell name:
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Format Data and appearance (Design View)
Please see the table for the available Data Types and there sizes a database can hold a maximum of 2 gigabytes of data.
Data type

Use to store

Size

Text

Alphanumeric characters

Up to 255 characters.

Use for text, or for numbers that are not used in calculations
(for example, a product ID). A numeric value that is stored as
text can be sorted and filtered more logically, but cannot be
easily used in calculations.
Memo

Alphanumeric characters (longer than 255 characters in
length) or text that uses rich text formatting.
Use for text that is more than 255 characters in length,
or for text that uses rich text formatting. Notes, lengthy
descriptions, and paragraphs that use text formatting, such
as bold or italics, are good examples of where to use a Memo
field.

Number

Numeric values (integers or fractional values).

Up to 1 gigabyte of characters, or
2 gigabytes of storage (2 bytes per
character), of which you can display
65,535 characters in a control.

1, 2, 4, or 8 bytes, or 16 bytes when
used for a replication ID.

Use for storing numbers that are used in calculations,
except for monetary values (use the Currency data type for
monetary values).
Date/Time

Dates and times.

8 bytes.

Use for storing date/time values. Note that each value stored
includes both a date component and a time component.
Currency

Monetary values.

8 bytes.

Use for storing monetary values (currency).
AutoNumber

A unique numeric value that Access automatically inserts
when a record is added.

4 bytes or 16 bytes when used for
replication ID.

Use for generating unique values that can be used as a
primary key. Note that values for AutoNumber fields can be
incremented sequentially or by a specified value, or assigned
randomly.
Yes/No

Boolean values (yes/no).

1 bit (8 bits = 1 byte).

You can use one of three formats: Yes/No, True/False, or On/
Off.
OLE Object

OLE objects or other binary data.

Up to 1 gigabyte.

Use for storing OLE objects from other Microsoft Windows
programs.
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Pictures, Images, Binary files, Office files.
This is the preferred data type for storing digital images and
any type of binary file.

Hyperlink

Hyperlinks.
Use for storing hyperlinks to provide single-click access to
Web pages through a URL (Uniform Resource Locator) or
files through a name in UNC (universal naming convention)
format. You can also link to Access objects stored in a
database.

Lookup
Wizard

For compressed attachments,
2 gigabytes. For uncompressed
attachments, approximately 700kb,
depending on the degree to which the
attachment can be compressed.
Up to 1 gigabyte of characters, or
2 gigabytes of storage (2 bytes per
character), of which you can display
65,535 characters in a control.

Not actually a data type; instead, this starts the Lookup
Wizard.

Table or query based: The size of the
bound column.

Use to start the Lookup Wizard so that you can create a field
that uses a combo box to look up a value in another table,
query, or list of values.

Value based: The size of the Text field
used to store the value.
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Design View Ribbon Features
Access 2010 features a special contextual tab that deals with Table Design:

Views
This command switches back and forth between the different views of a table:

Primary Key
This command toggles the primary key property for a field on and off. Although relatively rare, it is possible for a table
to have more than one primary key.
Builder
Use this command to activate the expression builder. The expression builder is used to create logical expressions used to
help ensure data is properly entered into a table. We will explore the use of this command in this lesson.
Test Validation Rules
This command will check any logical expressions built with the expression builder as well as other properties of a table
to ensure there are no inconsistencies.
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Insert Row
Use this command to insert a new field above the currently selected row in Design view.
Delete Rows
This will remove the currently selected field from Design view.
Modify Lookup
A lookup column is a special type of combo box used to enter data into a table. You can fill the lookup column with your
own data, or use data from another table. Lookup columns are very useful in using information contained in a different
table. We will explore lookup columns in this lesson.
Property Sheet
In addition to having field properties, each field has another set of properties you can modify that deal with more advanced
properties. Though some are duplicates of the field properties, most of these properties are beyond the scope of this manual.
Indexes
This command is used to modify the background properties of an index you can apply to a field.
Relationships
We will look at this later in great depth as it is the core of a reltional database
Field record & table events
Allows the viewing and setting of those macros within a table covered later in the manual.

Text Fields
Entering the field name and setting the Data Type are very important and for each field entered this should have been
thought out beforehand. Setting say the customer name field to a text Data Type is one thing or setting the date of birth
to date/time is another. But there are various data formatting options in the properties section of the field. That change
the appearance of the data when you return to datasheet view.
There are two types of text fields in Access: Text and Memo. Open a table in Design view to adjust its field properties.
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Text
The Text data type is probably the most overall used data type in a database. Its properties are similar in nature to the
Number data type, meaning it can have an input mask, validation rules, and a default value. The IME Sentence Mode,
IME Mode, and Unicode Compression all deal with translation properties when converting a database in one language to
another, like from Japanese to English. Text fields can contain essentially every letter, character, and number. Text fields
can also be set for a certain number of characters; 255 characters is the maximum size. Text fields in Access 2010 feature
a new property, the ability to align text inside a field. This field is found at the very bottom of the list: beneath smart
tags(use the scroll bar to the right.)

Memo
The Memo data type is very similar to the Text data type. The only real differences between the two are that a memo field
can be much larger, up to 65,636 characters (roughly 35 pages of solid text!) Memo fields in Access 2010 also let you only
append data to a memo field. That is, when you attempt to add data to a memo field, it will only be added to the end.
You cannot overwrite any previous memo information by accident.
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Text Field Size

ӹӹ To set the text field size
mouse
1. Open the table that contains the field that you want to change.
2. Select the field for which you want to change the field size, and then on the ribbon click the Modify Fields
tab.
3. In the Properties group, click More, and then click Field Size.
4. Enter the new field size in the Field Size box. You can enter a value from 1 to 255. This number specifies
the maximum number of characters that each value can have. If you need more than 255 characters, use the
Memo data type instead.
•

For data in a Text field, Access does not reserve space beyond what is necessary to hold actual values. The
Field Size property is the maximum field value size.

Number Fields
There are three types of number Data Typefields in Access: AutoNumber, Number, and Currency. To apply this
new format, first open a table in Design view to adjust its field properties. (Date/time is treated as a number for certain
reasons but not in this case)

> Apply now
redefine your future

- © Photononstop

AxA globAl grAduAte
progrAm 2014

Download free eBooks at bookboon.com
axa_ad_grad_prog_170x115.indd 1

19/12/13 16:36

32

Click on the ad to read more

Access 2010: Part II

Tables

AutoNumber
The AutoNumber data type is used by Access to automatically count up by one or assign a random number each time
a new record is added to a table. AutoNumbers are usually used as primary keys to ensure uniqueness in data. If values
1, 2, and 3 were used as an AutoNumber type, and you delete record 2, the number 2 is not reused as an AutoNumber.

Number
The Number data type is a more general number that can be used and formatted in many ways. Field Size indicates what
data type the number itself will be: either Integer for whole numbers, or Double for decimal values or very large positive/
negative values and/or decimal values. You can also assign an input mask, a default value, and validation rules to a number
(we will cover these topics later).
The only limitation on a number field is that the values inputted can only be numbers! If you try to enter any letters of
the alphabet, Access will warn you that you are attempting to enter an invalid data type into the field.
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Number Format
You may set the number format once you have set the Data Type from the format dropdown box in the properties
section
Format

Use to display

General

Numbers without additional formatting exactly as it is stored.

Currency

General monetary values.

Euro

General monetary values stored in the EU format.

Fixed

Numeric data.

Standard

Numeric data with decimal.

Percentage

Percentages.

Scientific

Calculations.

Number Field Size
If the field for which you want to change the field size already contains data, consider making a backup of your database
before you proceed.

ӹӹ To change field size
mouse
1. In the Navigation Pane, right-click the table that contains the field that you want to change, and then click
Design View.
2. In the table design grid, select the field for which you want to change the field size.
3. In the Field Properties pane, on the General tab, enter the new field size in the Field Size
property. You can choose from the following values:
-- Byte— For integers that range from 0 to 255. Storage requirement is a single byte.
-- Integer— For integers that range from -32,768 to +32,767. Storage requirement is two bytes.
-- Long Integer— For integers that range from -2,147,483,648 to +2,147,483,647. Storage requirement is
four bytes.
•

Use the Long Integer data type when you create a foreign key to relate a field to another table’s AutoNumber
primary key field.

-- Single— For numeric floating point values that range from -3.4 x 1038 to +3.4 x 1038 and up to seven
significant digits. Storage requirement is four bytes.
-- Double— For numeric floating point values that range from -1.797 x 10308 to +1.797 x 10308 and up to
15 significant digits. Storage requirement is eight bytes.
-- Replication ID— For storing a GUID that is required for replication. Storage requirement is 16 bytes.
•

Replication is not supported using an .accdb file format.

-- Decimal— For numeric values that range from -9.999... x 1027 to +9.999... x 1027. Storage requirement is
12 bytes.
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Currency
The Currency data type is very similar to the Number data type; the only difference is that a currency is permanently
defined as a Double data type.

Data And Time
Choosing the date and time Data Type allows you the following format options in the properties sheet
Format

Use to display

Short Date

Display the date in a short format. Depends on your regional date and time settings. For example, 3/14/2001
for USA.

Medium
Date

Display the date in medium format. For example, 3-Apr-09 for USA.

Long Date

Display the date in a long format. Depends on your the regional date and time settings. For example,
Wednesday, March 14, 2001 for USA.

Time am/pm

Display the time only using a 12 hour format that will respond to changes in the regional date and time
settings.

Medium
Time

Display the time followed by AM/PM.

Time 24hour

Display the time only using a 24 hour format that will respond to changes in the regional date and time
settings

Yes/No
Yes no is used where a checkbox in a datbase would be useful it can have only one of two values
Data Type

Use to display

Check Box

A check box.

Yes/No

Yes or No options

True/False

True or False options.

On/Off

On or Off options.
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Not all properties are available for every field. A field’s data type determines which properties it has.
Field property

Description

Field Size

Set the maximum size for data stored as a Text, Number, or AutoNumber data type.
For best performance, always specify the smallest sufficient Field Size.

Format

Customize the way that the field appears by default when displayed or printed.

Decimal Places

Specify the number of decimal places to use when displaying numbers.

New Values

Specify whether an AutoNumber field is incremented or assigned a random value when a new record is
added.

Input Mask

Display characters that help to guide data entry. For more information about creating and using an input
mask, see the See Also section.

Caption

Set the text displayed by default in labels for forms, reports, and queries.

Default Value

Automatically assign a default value to a field when new records are added.

Validation Rule

Supply an expression that must be true whenever you add or change the value in this field.

Validation Text

Enter a message to display when a value violates the expression in the Validation Rule property.

Required

Require that data be entered in a field.

Allow Zero
Length

Allow entry (by setting the property’s value to Yes) of a zero-length string (“”) in a Text or Memo field.

Indexed

Speed up access to data in this field by creating and using an index.

Unicode
Compression

Compress text stored in this field when a small amount of text is stored (< 4,096 characters).

IME Mode

Control conversion of characters in an East Asian version of Windows.

IME Sentence
Mode

Control conversion of sentences in an East Asian version of Windows.

Action Tags

Attach an action tag to this field. (action tags: Data recognized and labeled as a particular type. For example,
a person’s name or the name of a recent Microsoft Outlook e-mail message recipient is a type of data that
can be recognized and labeled with an action tag.)

Append Only

Track the history of field values (by setting the property’s value to Yes).

Text Format

Choose the property’s Rich Text value to store text as HTML and allow rich formatting. Choose the property’s
Plain Text value to store only unformatted text.

Text Align

Specify the default alignment of text within a control.

Understanding Field Properties
You should now be familiar with the basics of tables and understand fields and rows. In this lesson, we will explore tables
in more depth and learn about their attributes and how they can be modified.
Every field in every table in every database has properties. In fact, you will learn that nearly everything in the entire Access
program has properties of some type to modify! To see the field properties of a certain field, you must first open a table
in Design view. Consider the Employees table from the Northwind sample database:
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Field properties are visible in the bottom half of Design view. Each field name has an associated data type. Each data type
will have different properties that you can define to make the table contain exactly the data you need. We will explore
Field Properties in depth later in this manual.
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Indexing A Field
An index is designed to help speed up a search. When you look up something in an encyclopaedia, and the subject starts
with the letter Q, you are not going to start looking at A in the index and browse until you reach Q! You will start at Q
because you know the value is not in any of the sixteen previous letters. The same principle applies to a database.

ӹӹ To index a field
mouse
1. To index a field, first view the table in Design view:
2. The current field, which also happens to be the primary key, is indexed. There are three options when
indexing:

No
No indexing will be performed on this field
Yes (Duplicates OK)
The database will allow for multiple rows that have the same field value. Vehicle ID would not use this feature because
it is the primary key. But if you have several rows that have the same model name, and have several different models in
your database, this option makes database updates slower, but makes searches faster (in the case of very large databases).
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Yes (No Duplicates)
The opposite of the above feature; if you have several rows with the same make, only the first row instance will be indexed.
This makes database updates faster but will decrease search time somewhat (in the case of very large databases).
•

The only data types you can’t index are Memos and Hyperlinks.

Import A Table From Another Database
We have already covered how Access can import and export data from an external source in the previous section. Access
2010 features import and linking operations together in the same command group located in the External Data ribbon.
In this lesson we will explore how to import an entire table from an external source.
In this example, we will import the contents of a table from the Northwind sample database.

ӹӹ To import a table
mouse

3. Open the destination database and click the Access command in the External Data ribbon:
4. The Get External Data – Access Databasedialogue box will appear. Click the Browse button
to locate the file and make sure the “Import tables, queries, forms…” radio button is selected:
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5. The Import Objectsdialogue box will appear.(next Page) Click each object you want to import one at a
time from the Tables tabs at the top (or click Select All to highlight all under a single tab).
6. For more advanced options and to change how Access will import objects, click the Options button:
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7. Click -OK- and the entire selected table will be imported into your database. Access prompts you to save
the import operation if you like. The table will be displayed in the Tables object page of the Database
window. Since you have imported the data (as opposed to linking it) you have full access to do whatever you
like to the data. The source file will not be touched.

Relationships
Standard database design protocols
-- When naming an object prefix it with tbl for table qry for query frm for form etc.
These prefixes make it easy to identify an object when they have similar names such as TblCustomer and FrmCustomer
-- When naming an object capitalise each word and use no spaces
This will be memorable and easier to use use in the building of calculations the captions option in the field properties
allow the user to see the name of the field in a normal way with spaces or any other characters you wish to use.
-- Only use letters and numbers in the field name.
Many characters outside the alphabet are reserved for specific use and even when not make it harder to create calculations
later on.
-- Always refer to the object in the singular
This then will be a memorable standard when performing advanced expression and calculation building
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Creating Table Relationships
In this section we will explore the staple that really makes a database work: the relationships that are established between
the different tables of data. When designing a database, this is the most challenging step and often the place where most
of the confusion with databases arises. Fortunately, databases are nothing more than tables of data that are related.

Consider the following simple database

Imagine your database has a table of employees, and a table of expenses that have been made by your employees. As
time goes by, the Expenses table will grow to become quite large. You wish to make a query that will find out the phone
number of every employee that submitted an expense. It is impractical to place the employee phone number in the same
table as the expenses. It will create a lot of extra data that is not really needed if there is another table containing employee
data elsewhere. The relationship between the two tables is created because of the two common fields,-EmployeeID-. In
particular, the Employees table and the Expenses table are in a “one-to-many” relationship, meaning that one entry in the
Employees table can relate to many entries in the Expenses table.
Knowing this, we can add two relationships to our expanded Vehicles Database. You can view the relationships by clicking
the Relationships command in the Database Tools ribbon:

ӹӹ To access relationships
mouse
1. Ensure tables are saved and closed (good practice)
2. On the database tools ribbon, relationships group click on the relationships button
3. A tab will appear in the main window called relationships.
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4. A dialogue will be in front of the window asking which tables you would like to add.
5. Double click each table you would like to appear in the relationship window
or
1. Select a table and click the add button.
2. When all tables are added click close
3. The relationship window should appear as below

-- You may click with your left mouse button on the titles of these objects to drag they around and reposition
them
-- You may move your mouse to a border where a resize (double arrow) handle will allow you to change the
size of the object.
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Instead of naming every country and manufacturer in the Vehicles table, we can lighten the size of the Vehicles table by
taking those two pieces of information and storing them in a separate location. In a database of this size this may not
seem like that big of a deal, but as we proceed through this manual, the reasoning will become clearer.
Make and Country in the previous Vehicles table are replaced by ManufacturerID and CountryID. The TblManufacturer
and TblCountry tables listed above contain only the respective ID and name for each record. However, Access does not
automatically recognize the relationships by itself; we must tell it which fields relate in these tables.

ӹӹ To create a relationship
mouse
1. Click on the database tools ribbon, Show hide group, relationships button to show relationships
window.
2. The contextual design ribbon appears click on the show table button in the relationships group.
3. Add tables you wish to relate click on close.
4. To establish a relationship between the Vehicles and Manufacturers tables, simply click and drag the
Manufacturer ID field from one table to another:

5. When you release the mouse button, you will see the Edit Relationships dialogue box:
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6. Access has determined that the style of this relationship is One-To-Many, based on the data that was
collected from the drag and drop operation. Before clicking the Create button, you should click the
Enforce Referential Integrity check box.
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Referential Integrity is a set of rules and conditions that make data entry into databases safer. You should try to enforce
referential integrity whenever possible. It insures that all related fields are valid when considered together in a database,
and prevents you from accidentally deleting related data. To make referential integrity work, the following three conditions
must be satisfied:
-- The matching field from one table is a primary key or has a unique index. (True: ManufacturerID is the
primary key)
-- The fields in the relationship have the same data type. (True: both fields are numerical)
-- Both tables are stored in the same database. (True: both tables are in the same database file, not a linked
table.)
7. Since all of the necessary conditions have been satisfied, click Create to establish the relationship:

8. You can see the one-to-many relationship in the diagram above. One ManufacturerID from
TblManufacturer may correspond to many ManufacturerID’s from TblVehicle.
9. Create the country relationship in the same way.
10. Now let’s examine the relationships in the Northwind sample database. As you can see in the diagram below,
there is a lot of action happening in this database!
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11. Let’s examine the Products table in this database: (Next page)
Each product record contains many attributes describing the nature of the product that Northwind sells, one of which is
an ID field. In fact, each relationship in the Product table is based on the ID field. There are four relationships denoted
by black lines coming from the ID field, relating to Inventory Transactions, Purchase Order Details, Inventory Restocking
Details, and Order Details. Consider the relationship with the Order Details table. One product that Northwind sells has
the potential to be sold many times, therefore each sale of each product is logged in the Order Details table. The Products
table is in a one-to-many relationship with the Order Details table.
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Creating the relationships is very simple if the fields in your tables have been well planned; simply drag and drop fields.
The Northwind database does not follow the principals of naming we looked at earlier so it may prove to be difficult later
to deal with calculations very untidy.
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Deleting Relationships
When deleting a relationship, remember that doing so can have a big impact on how the database works. Make sure you
actually do need to remove the relationship!
1. Deleting a relationship in the Relationships window is easy, just right-click on the relationship you want to
remove and click Delete:

2. Access confirms that you want to delete the relationship,

3. Click -Yes- to confirm.

Controlling Data EntryIn a Table.
In this lesson of this section, we will explore some more advanced table data entry techniques. These methods, combined
with all of the controls that can be enforced from previous sections, help protect your database from bad data entry.

Data Validation Numerical Data
In addition to adding protection like required values and input masks, you can also add validation rules to your database
to ensure that data entered makes sense.
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ӹӹ To create a rule
Consider the Vehicles table. The Number of Cylinders field has a default value of 6 and the Field Size is defined as Integer,
which prevents decimal numbers from being entered. The field Description states that if a vehicle is equipped with a
rotary engine (one that has no cylinders) that 0 should be the value. Therefore, a data entry is valid if it is a whole number
greater than or equal to zero. However, no precautions are in place to prevent someone from entering a negative number
of cylinders, a data entry that does not make sense.
mouse
1. By clicking in the Validation Rule box, you can enter a simple expression, >=0.

2. This will prevent someone from entering a negative number of cylinders:

3. Back in Design view, you can click the

button beside the Validation Rule field to launch the Expression

Builder:
4. The Expression Builder lets you create customized validation rules, expressions, logical functions, and much
more. We will explore the basic functionality of the expression builder later in this manual.
Remember although the default value is 6 cylinders someone may enter 60, 1000, 50,000.To limit the number of cylinders
entered add more conditions using the “AND” or “OR” operators to set a range of values that may be entered.
5. To limit the entries to a range of values instead of just entering >=0 we could add the AND command and
enter a second condition to create the value range greater than zero and less than 12
>=0 And <=12
6. Enter some explanatory validation text which will be the prompt (error Message that will appear if incorrect
data is entered
7. Try this and see the error message at any value outside this range.
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Data Validation Textual Data
As another example of validation consider the vehicle table we cannot use the>(greater than or less than)< signs when
referring to text we are looking to allow entry only of specific strings of text. For instance if the cars in the previous example
were only made in specific colours say Blue, Red and Green we would not want anyone to enter either a misspelling or
a different colour.

ӹӹ To validate text
mouse
1. Open the vehicles table in design view
2. Select the colour field
3. In the validation box enter the values Red or Blue or Green and press return.
4. Access will adjust the validation rule to read “Red” Or “Blue” Or “Green”

5. Enter some explanatory validation text which will be the prompt (error Message that will appear if incorrect
data is entered
6. The colours are text strings and the word OR is recognised as a command in access, when data is entered in
this field now only one of those three colours will be allowed to be entered in the cell any variation on these
values will give an error message.
7. Further criteria for building validation will be seen later in the filtering and queries sections.

Download free eBooks at bookboon.com

51

Access 2010: Part II

Tables

Setting A Default Value
A default value is something that is always present in a particular field whenever a new record is made.
E.G.If you own a company with its base of operations in New York, you can assign a default value of ‘New York’ in all
of the address fields you might use in a database. Every time you go to enter a new employee’s information or customer
invoice, the city field will always be ‘New York’ until you change it to something else.

ӹӹ To create a default value
mouse
1. Open a table in Design view, click the field you want to give a default value,
2. Type a default value in its corresponding field property. In our example, we will make the default number of
cylinders 6:
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Setting A Required Value

A required value is a value that must be entered into a record in order for the database to be considered complete. If you
have ever filled out a form on the Internet, you usually see an asterisk (*) beside fields that must be entered in order for
a data entry to be valid:
3. Making a value a required value is as simple as clicking yes or no in the -Required- combo box:

Creating A Lookup Field
The current Vehicles table has been populated with some information. We already established the relationships with the
Countries and Manufacturers tables. However, having a Manufacturer ID of 3 and a Country ID of 5 is not very meaningful
when looking just at the Vehicles Table:
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Lookup Wizard
Fortunately, Access features something called a lookup field. It allows you to use the actual Manufacturer name and
Country name to enter data in the field. Creating a lookup field is easy; however you must first delete the relationship(s)
that exist in the field.
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ӹӹ To use the lookup wizard
mouse
1. First, open the Vehicles table in Design view. Click in the Data Type cell of the field you want to
turn into a lookup table and click Lookup Wizard.

2. The Lookup Wizard will appear.
3. Select the data source you will use for your lookup field. In our case, we want to use the data contained in
the Manufacturers table: (next Page)

4. The next step allows you to choose which table (or query) contains the lookup values; in our case the
Manufacturers table:
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5. The next step lets you choose which field or fields in the source table you want to use for your lookup field.
In our case, we want to show the Manufacturer name instead of just the ID:

6. In the next step you have the option to sort the values that will appear in the field in ascending or
descending order. If you do not specify anything in this step, Access will automatically apply an ascending
order on the field that was used to create the filter:
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7. The next step allows you to move your mouse to the edges of the column and click and drag to adjust the
size. You can also opt to show the primary key column, which will show the corresponding primary
key for each value in the lookup field:

8. The final step of the Wizard will give the lookup field a name. and allow you to enable data integrity This
will replace the column name of Manufacturer ID. Click Finish:
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9. Return to Datasheet view once the Wizard completes. If you click in the Manufacturer’s Name
column of data, the field becomes a combo box. If you need to change the value to something else, click the
pull-down arrow to see a list of available values:
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10. As part of the lookup field creation process, Access created a basic relationship between the Vehicles and
Manufacturers table:

11. However, the relationship is not a strong one. Right-click the black line joining the two tables and click
Edit Relationships:

Download free eBooks at bookboon.com

59

Access 2010: Part II

Tables

12. Click the Enforce Referential Integrity check box and click OK. The full relationship will be
restored:

Modifying A Lookup Field
Now that you know how to establish a lookup field, you can modify certain characteristics of the field to suit your database’s
needs. If you open a table in Design view, you can view the lookup field properties by clicking the Lookup tab at the
bottom of the window:

The following properties are available to adjust:
Display Control
You can choose between a Text Box, List Box, or Combo box for the lookup field.

Download free eBooks at bookboon.com

60

Access 2010: Part II

Tables

Row Source Type
You can specify between Table/Query, Value List, or Field List.
Row Source
The query or data that the lookup field uses.
Bound Column
Lists how many columns that currently constitute the lookup field.
Column Count
Number of columns that are available to use as a lookup field.
Column Heads
Can specify Yes/No if a field label, caption, or first row of data used to construct the lookup field values will be used.
Column Widths
Lists the dimensions of the columns used in the lookup field. The number of columns in the Column Count field, are the
same number of dimensions listed here.
List Rows
Maximum number of rows that are displayed if combo box is the specified Display Control.
List Width
Width of the combo box if specified as Display Control.
Limit to List
Forces user to use only the values in the lookup field; that is they cannot enter any data not specified by the query.
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Allow Multiple Values
Access 2010 allows you to view multiple items in the lookup column at once, just like the login screen for the Northwind
sample database:
Allow Value List Edits
Lets you edit the values that are contained in the lookup column.
List Items Edit Form
If the above property is set to Yes, specify which form you wish to use in order to modify the lookup values.

www.sylvania.com

We do not reinvent
the wheel we reinvent
light.
Fascinating lighting offers an infinite spectrum of
possibilities: Innovative technologies and new
markets provide both opportunities and challenges.
An environment in which your expertise is in high
demand. Enjoy the supportive working atmosphere
within our global group and benefit from international
career paths. Implement sustainable ideas in close
cooperation with other specialists and contribute to
influencing our future. Come and join us in reinventing
light every day.

Light is OSRAM

Download free eBooks at bookboon.com

62

Click on the ad to read more

Access 2010: Part II

Tables

Creating A Lookup VALUE List
We have seen in the last section of this lesson that you can use a table to retrieve lookup field values. However, Access
gives you the ability to specify the values that can be used in a lookup field yourself.
In this example, we will help prevent improper data from being entered into the Number of Cylinders field of the Vehicles
table. We will create a value list that will let a user pick how many cylinders a car has from a list of options.

ӹӹ To create this value list,
mouse
1. open the Vehicles table and enter Design view.
2. In the Data Type field of Number of Cylinders, select Lookup Wizard.

3. The Lookup Wizard window will appear. Select the second radio button “I will type in the
values that I want” and click -Next-:

4. The next page of the Wizard is where you enter the values you want to use for the value list.
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5. In this page of the Wizard you can specify the number of columns for the value list and which values you
want to include in the list. (The majority of lookup fields/value lists you will use will only be a single field at
a time.) Click your mouse inside the first cell, type a value, and press Tab on your keyboard to move to the
next cell. When you have entered the list of values you want to use, click -Next-.

6. The final step of the Wizard asks you to name the lookup column (value list). The default name is the same
name as the field, but you can name it whatever you like. Click Finish to complete the Wizard.
7. If you open Datasheet view for the table you will be able to use the combo box to fill in a value for the field.

Modifying A Lookup VALUE List
Modifying the properties of a value list is essentially the same as those for a lookup field.
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ӹӹ To modify a value list
mouse

1. Click the Lookup tab located at the bottom of Design view:
2. The only difference between this value list and any lookup field is the ability to see and modify all of the
values currently assigned in the Row Source field. You can add or delete as many as you like, but make
sure that each value is separated by the delimiting semicolon.
We will continue our examination of tables in this lesson by learning how to make table entry even more precise, further
eliminating the risk of having bad or incorrect data entered into the database. We will look further into lookup fields later on.

Creating And Using Input Masks
An input mask is defined as a type of template that is used when entering data into a field that follows some sort of format.
For example, the phone number 4827482234 is much harder to read than (482) 748-2234. Access can set up input masks
to make sure data is entered completely and correctly. The Employees table in the Northwind sample database makes use
of such an input mask:

An input mask is A format that consists of literal display characters (such as parentheses, periods, and hyphens) and mask
characters that specify where data is to be entered as well as what kind of data and how many characters are allowed.
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ӹӹ To create an input mask
mouse
1. Different data types have different input masks. To setup or modify an input mask, open a table in Design
view:

2. Then, open the field’s properties and find a field that does not offer the option to type or choose from a
combo box. Click it and a small symbol will appear (

) on the right-hand side.

3. Click it to start the Input Mask Wizard:
4. Here you can select from the various input masks that are available. The first option is the phone number
mask; give it a try by clicking in the Try It: text box and typing. Click Next.
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5. Here you can change the placeholder character to some other symbol than the underscore character. Click
Next.

6. You can choose how you would like to store the data in the table, either with the symbols or without the
symbols. If you choose to keep the symbols in the database to make the data easier to read, you must make
sure the data type for the Phone Number field is Text as non numerical characters are not allowed in a
Number field. Click -Next-,
7. Click Finish- to complete the Wizard. If you close the Employees table Design view, and then open the
table in Datasheet view, you will see that the Phone field has the input mask applied to it:
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CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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Input mask Syntax
Microsoft Access interprets characters in the Input Mask property definition as shown in the following table. To define
a literal character, enter any character other than those shown in the table, including spaces and symbols. To define one
of the following characters as a literal character, precede that character with a backslash (\).
Character

Description

0

Digit (0 through 9, entry required; plus [+] and minus [-] signs not allowed).

9

Digit or space (entry not required; plus and minus signs not allowed).

#

Digit or space (entry not required; blank positions converted to spaces, plus and minus signs allowed).

L

Letter (A through Z, entry required).

?

Letter (A through Z, entry optional).

A

Letter or digit (entry required).

a

Letter or digit (entry optional).

&

Any character or a space (entry required).

C

Any character or a space (entry optional).

.,:;-/

Decimal placeholder and thousands, date, and time separators. (The actual character used depends on
the regional settings specified in Microsoft Windows Control Panel.)

<

Causes all characters that follow to be converted to lowercase.

>

Causes all characters that follow to be converted to uppercase.

!

Causes the input maskto display from right to left, rather than from left to right. Characters typed into
the mask always fill it from left to right. You can include the exclamation point anywhere in the input
mask.

\

Causes the character that follows to be displayed as a literal character. Used to display any of the
characters listed in this table as literal characters (for example, \A is displayed as just A).

Password

Setting the InputMask property to the word Password creates a password entry text box. Any
character typed in the text box is stored as the character but is displayed as an asterisk (*).
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Input mask examples
The following table shows some useful definitions and examples of values you can enter into them.
Input mask definition

Examples of values

(000) 000-0000

(206) 555-0248

(999) 999-9999!

(206) 555-0248 or( ) 555-0248

(000) AAA-AAAA

(206) 555-TELE

#999

-20
2000

>L????L?000L0

GREENGR339M3 orMAY R 452B7

>L0L 0L0

T2F 8M4

00000-9999

9811598115-3007

>L<??????????????

Maria
Pierre

ISBN 0-&&&&&&&&&-0

ISBN 1-55615-507-7 orISBN 0-13-964262-5

>LL00000-0000

DB51392-0493

Enter Data In a Table
Using A Table
Access 2010 provides you with a few ways of entering data. You can enter in the data manually, use a form, or use the
Import commands in the External Data ribbon.

ӹӹ To enter data manually
1. Open a table in Datasheet view by double-clicking its name in the Navigation Pane. If you make an error
while entering data, like accidentally entering a word into a number field, Access will prompt you with an
error stating so.
2. if you try to enter non-numeric characters into the SIN field of the Warner Cousins database, you will see
the following appear:
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3. There may be an instance where it is necessary to have both letters and numbers in the same data field (such
as the Phone field). Luckily, the Text data type allows you type in any characters you like.

360°
thinking

Formatting A Table in Datasheet view

.

Access has always given you a great amount of flexibility when it comes to modifying the look and feel of the objects in
your database. Access 2010 is no different, letting you modify just about everything you can think of.
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Format Font

ӹӹ To format Font
mouse

1. If you create a new table and enter some data, the result is straightforward and clean:
2. The commands in the Text formatting section of the Home ribbon let you modify the font, font
size, text style, orientation, gridlines, fill colour, and more, for the entire table.
Any modifications you perform will be applied to the entire table.

Table Format
If you have ever used Access before, chances are you noticed one of the new enhancements right away – the alternating
background colours in the different rows of the table. You can modify the background colour by clicking the text
formattingdialogue box launcher on the Home ribbon:
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ӹӹ To change table appearance
mouse

1. Click the text formattingdialogue box launcher on the Home ribbon
2. Change the cell effect from the options given
3. Change how you wish gridlines to be seen. Untick those you wish not to see.
4. Choose a gridline colour.
5. Change the alternating colours for your table this makes it much easier to read your data.
6. Choose from the options given, from the drop down boxes, your border styles
7. Select a text direction
8. All options should show in the sample area of the dialogue
9. When all options have been made click ok to apply the changes or cancel to discard them.

Row Height / Column Width
Occasionally you may have very large (or very small) amounts of data to put into a table. For example, Access features
a Memo data type that can hold a total of 65,535 characters – that’s about 40 pages of solid text! You can expand the
dimensions of rows and columns in order to be able to view the contents of a table.
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Send us your CV. You will be surprised where it can take you.
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ӹӹ To change row height/column width
mouse
1. To do this, click the More command in the Records section of the Home ribbon. In the drop down
menu you will see entries for Row Height and Column Width:
2. With Row Height, you can specify a unit of measurement or leave it at Standard height:
3. With Column Width, you can specify a unit of measurement for width or choose Best Fit, which
will automatically adjust the column to the width of the widest field’s entry: ,

Or
You can also adjust the row height and column width manually.
1. Place your mouse on the lines dividing the rows and columns from each other. Your mouse will turn into a
double-headed arrow
(

for rows,

for columns).

2. Click and drag in the dimension displayed by the arrow to drag the height or width.

Working with records
About Records
So far we have come a long way in our exploration of Access. By now you should be comfortable with the basics of
navigating the interface and the use of the Navigation Pane. We are now ready to explore the real stuff databases are made
of, as well as begin to build one of our own.

What Is A Record?
We defined a record in Section 1 of this manual as a collected group of fields. More formally, a record is defined as one
or more fields of data that create a single entry in a table. We have also learned that each record should have a primary
key; that is, some unique identifier that sets it apart from every other record in a table.
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Navigation Tips
Imagine you are working on this simple table in Datasheet view:
Before discussing how to move around inside a table, let’s take a quick look at the features Access 2010 has automatically
added. The ID field was automatically inserted to use as a primary key. Every table should have a primary key of some
sort, but it is not necessary.

Field1 and Field2 are column headers that identify a column of data. The last field, Add New Field, is also an automatic
placement by Access. This is not a column of data like the others, but can easily become one should you need it.
The field in the upper left-hand corner is currently highlighted in orange. To move the cursor to a different field you can
use the mouse and click inside any other field. You can also use the arrow keys on your keyboard to move the selection
to a different field.
Using the mouse and keyboard is fine for tables of data that can fit on your screen; however the majority of tables in
databases are usually quite long. It becomes impractical to scroll up and down or press and hold the arrow keys to reach
your destination. There is a small toolbar at the bottom of Datasheet view available to deal with this exact problem:

To browse through the various records, use the small arrow icons:
First

Moves to the first record in the table.

Previous

Moves to the previous record.

Next

Moves to the next record.

Last

Moves to the last record in the table.

New

Creates a new record at the end of the table.
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You can also apply a custom filter to the table by clicking the filter button. Access also lets you search for a particular entry
by using the Search text box. Simply type in the keyword or number you are looking for and press Enter.
At the very bottom of the Access window, in the status bar on the right-hand side of the screen, you will see a few small
icons. These icons denote which view you are currently using to work with the current object. In the diagram above, the
available views of a table are listed (Datasheet view which is currently highlighted, and Design view).

Adding Records
There are a few different ways to create a new record. Try using all of them; depending on your level of experience with
using computers you will likely find one that is easy for you to use.
The first method is likely the easiest if you are very comfortable using a keyboard. If you are entering data using the
keyboard, enter the data you need into a field and press Enter on your keyboard. If you have reached the Add New Field
column of data and press Enter again, you can now type in that column. Pressing Enter once more will bump the Add
New Field down one column, and so on until you have added as many fields as you like to a record.
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ӹӹ To add records
mouse or keyboard
Method 1
1. If you are entering data using the keyboard, pressing Tab will also advance you to the next field in the row.
However if you have reached the end of the record and press Tab again, you will move to a new record.
Method 2
1. Go to the the Home ribbon. The Records section of the ribbon contains a New record command (
); click this to make a new record at the end of the table.
Method 3

1. Use the navigation bar located at the bottom of Datasheet view:
2. This will create a new record at the end of the table.

Editing Records

If you made an error, or need to change the information in a record manually, simply open the table containing the data,
scroll to or search for the data field you need to change, click inside the field and enter the new information. As you are
entering data into a table, a small pencil icon will appear to the left of the record you are currently writing:
It is important to note that Access provides a little peace of mind by saving data automatically after every change to a
data field. It is not necessary to manually save the database after every change. The only field you cannot modify in this
way is the primary key. If there is some reason to modify the primary key, it is best to simply delete the record (described
below) and make a new one with a new primary key.
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ӹӹ To edit a record
mouse
1. Click within the cell that contains the data you wish to change
2. Change the data
3. Click on the pencil icon or move out of the record to save the change.

Deleting Records

ӹӹ To delete a record
mouse
4. Consider the following table:

5. If you want to delete a single record, click any of the boxes to the left of a record. This will select the entire
row of data:

6. Click the small pull down arrow beside the Delete command in the Home ribbon and click Delete
Record:

7. Access warns you that you are about to delete a record:
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8. Click -Yes- to confirm the deletion.
OR
1. Right-click the box to the left of the record and select Delete Record from the drop down menu:
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Deleting records in this manner is fine for a few, but impractical if you need to purge a lot of data from a table. Luckily,
Access allows you to delete multiple records at once. However, as a safety feature, you can only delete groups of adjacent
records. That is, you can’t merely pick and choose which records you want to delete and delete them all at once.

ӹӹ To delete a group of records
mouse
1. To select a group of records, click the box to the left of the first record you want to delete in order to
highlight that row:

2. While holding the Shift key down, click the box beside the last record you want to delete. This will
highlight a block of records:
3. Now click the Delete command on the Home ribbon and click Delete Record. You will be warned
this operation cannot be undone; click Yes to confirm the deletion.
If you prefer to use the right-mouse button, make sure you are still holding the Shift key and then right-click
any of the boxes to the left of the selected records. Click Delete Record and then Yes to confirm the deletion.

E-Mailing Records

Access allows you to e-mail records from a table in many different file formats. To perform this operation,

ӹӹ To email records
mouse
4. First select a record by clicking the box to the left of the record and highlighting the row, or hold the Shift
key and then select a group of records.
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5. For example, if you wanted to send records 2to 4 from the table above, first highlight all records:
6. Click on theExternal data Tab, the export group - E-mail button:
7. This will open the Send Object Asdialogue box:

8. Here you can choose which type of file format you want Access to convert your data into before sending.
If you are not sure which file format to use, selecting PDF Format (if you have installed the add-in) or
Text Files will likely be your best option. These two file types can be read by virtually every computer
platform. If the data is to be manipulated by the recipient an excel format will be a good choice as well.
9. Make sure the Selection radio button is selected in the Output section of the dialogue box.
10. Click OK. This will open a new message in your default mail program (like Microsoft Outlook or Outlook
Express) with a special attachment in the file format you have specified.
11. Enter the recipient’s e-mail address and click Send:
12. If you click the -All- radio button in the Send Object As dialogue box, Access will package the entire
database object in the file format you specify and then attach it to a new e-mail message.
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Using Undo And Redo
Undo and Redo are used as a way to recover or reinstate changes you have made to an object or file. Like Cut, Copy,
and Paste, you can perform the Undo and Redo command in many different situations using Access (and many other
programs). And like Cut, Copy, and Paste, Undo and Redo have their own keyboard shortcuts. (Ctrl + Z and Ctrl
+ Y respectively)

The Undo command is a standard control in the Quick Access toolbar:
The Redo command is used by pressing Ctrl + Y or by adding the control to the Quick Access toolbar:
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If you accidentally changed the font used in a control, use the Undo command to erase the changes and use the old font
again. Access gives you the option to ‘step back’ through the last twenty operations you performed.
To see the operations that were performed before, click the small pull-down arrow beside the Undo or Redo command:
Pick the option in the list you want to -Undo-; Access will revert the actions in the reverse order in which they were
performed.
The only exception to the Undo and Redo command is one that involves the deletion of data. If you are not 100% sure that
a certain piece of data can safely be removed, you should back up the database first. Should records be deleted because
of an Undo or Redo command, their deletion cannot be reversed.

Checking Your Spelling

In the case of a database, you probably won’t have too many spelling errors as most of the data is going to be in abbreviated
form, in number form, or proper names that won’t be in a dictionary. Nonetheless, Access lets you take advantage of a
spell checker to check the records of a table for misspelled words. For example, if you misspelled the word Street:
Access’ Check Spelling command will find and report an error like the one above if you activate the command in the
Records section of the Home ribbon:
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The Spelling dialogue box will appear with the word it couldn’t find in the Not in Dictionary field. The dialogue box
has several features to make spell checking easy. It offers possible spelling matches in the Suggestions list. You can also
specify which language you would like the spell checker to use in the Dictionary Language combo box. (Be warned that
changing dictionary languages may require the Office 2010 install media or a connection to the Internet to download a
language package.)
The buttons on the right-hand side of the dialogue allow you to:
Ignore
Skip over this instance of the misspelled word.
Ignore All
Skip over all instances of this misspelled word.
Change
Change this misspelled word to the highlighted suggestion in the Suggestions box.
Change All
Change all instances of this misspelled word to the highlighted suggestion in the Suggestions box.
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Add
Add this ‘misspelled’ word to the dictionary so any further instances will be considered correct.
AutoCorrect
AutoCorrect is a special function of the Microsoft Office Package that is designed to always change a misspelled word to
the first suggestion. For example, if you had to type ‘Street’ many times for different addresses but you always forget to
add the extra ‘e,’ Access will automatically correct every instance of ‘Stret’ to ‘Street’.

Printing Records
Office gives you the ability to print a selection of records.

ӹӹ To Print records
mouse
1. First, highlight the record(s) you would like to print:

Click File Tab - Print: The Print window on the right gives three options
2. Click on the Print button in the main window to open up the Printdialogue.
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3. When the Print dialogue box appears, specify the Print Range you would like to use and the number of
copies:
4. Select the printer if necessary.
5. Click OK to print the records. You can also select to print the entire object or only certain pages of the
object; we will cover more advanced print topics later in this manual.
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Sorting and Finding Data In a table
The databases we have been dealing with so far haven’t been very large. Most of the information available we could scroll
through in a few minutes. But if you are managing a library or government database, you might spend your entire day
looking through just one table and still not make it through.
Filters are like small specialized queries that are performed on a single table of information. Fortunately, Access has the
ability to sort and filter data in order to narrow down the results you need. In this lesson we will explore how to sort and
filter data in your database.

Using Find
If you are familiar with word processing and spreadsheet programs, you are probably familiar with find and replace
commands. Even Internet browsers feature a find command. These commands are designed to search a document of any
size quickly to find instances of a certain keyword or value and, if applicable, modify it.
You can use the find and replace commands on every database object except:
reports- Which are really just documents to be printed.
macros- A collection of commands, no actual data.
modules- Another sequence of commands, again no actual data.
You can find both commands Find and replace on the Home ribbon.
The Find command will search through an object and locate all instances of a keyword. The Find command also gives
you the ability to search only specific columns of data and flexibility in how it searches. If you only know part of a word
or phrase, you can search based on what you know.
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Find What
The Find What field lets you type in a certain word, part of a word, or a number. The keywords of any previous searches
you have performed will appear if you click the pull-down arrow.
Look In
The Look In field lets you search Field you are currently in, in the table or the entire current database object.
Match
If you are not 100% sure what you are looking for but at least have an idea, you can use different options in the Match
field.
Search
The Search field lets you conduct your search up, down, or all over the current object. For example, if you are looking
for a particular name that starts with ‘T’ in a very large database, you can save a lot of search time by searching at the
fields that start with T instead of the whole alphabet.
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Match Case
If you are looking for a certain organization name or something that is in all uppercase letter, you can have Access ignore
all lower case entries in its search which can increase the accuracy and speed of searching.
Search Fields as Formatted
Imagine you want to search for a record containing a particular date, and you type April 25, 2004. If this box is checked,
Access will search for all formats of this date, like 04/25/2004, 04/25/04, 25/04/04, 2004/25/04 and so on. Searching with
this box checked will slow down certain searches, but is more likely to find the data you need.

Using Replace
The Replace command is an extension of the Find command. It includes all the functionality of Find but lets you
modify all matches it finds to something else:

Enter the new word or phrase you want to replace in the Replace With field of the dialogue box. The Replace
button on the right-hand side of the window will find the next instance that matches the search criteria and replace it
with the new word or phrase. The Replace All command automatically scans the entire object listed in the Look
In combo box and replaces every match with the new word or phrase.
Be cautious; if you perform the Replace All command, you cannot undo the operation. You will have to do another
Find and Replace to change the fields back.
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Sort Ascending Or Descending
When viewing a table or query results in Datasheet view, you might want to sort through the records by hand if you
know what you are looking for. Access 2010 has a very quick way to sort through data listed in columns. Consider the
Employees table:

.
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ӹӹ To sort ascending descending
mouse
6. Click the column header (or headers) of the column(s) you wish to sort and then
7. Click either the Sort Ascending or Descending buttons: These commands can be found in the
Sort & Filter section of the Home ribbon.
Or
8. Click on the drop down arrow to right of a column (field) name and selecteither the Sort Ascending
or Descending buttons there.
9. The records in the table will sort themselves accordingly:

After applying a sort you may wish to change your mind

ӹӹ To Remove a sort
mouse
1. You can sort by another column
or
1. You may use the remove sort button in the sort and filter group

•

We will look at more advanced sorts later in the manual
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Filtering data in a table.
Toggle Filter
Access provides you with the ability to Filter and show records based on the values in a column of data.
E.G. if you wanted to show only the Sales Representatives,

ӹӹ To apply different filters
Mouse
1. Click the column header of any column in Datasheet view.

2. Click the Filter command in the Sort & Filter section of the Home ribbon:
Or

3. Click on the drop down arrow to right of a column (field) name
4. A drop down window will appear underneath the selected column header:
5. Click the Job Title column header to select the column
6. Show the drop down menu Uncheck all of the values listed in the drop down menu except for Sales
Representative.
7. Then, click OK to toggle the filter. Only the Sales Representatives will be shown in the table:

Download free eBooks at bookboon.com

94

Access 2010: Part II

Tables

ӹӹ To remove the toggle
mouse
1. Open the menu from the column header as previous
2. Tick the select all box
3. Click OKthe filter has been removed and all data is again visible

Using FilterBy Selection
Access makes it easy to filter a table of data quickly based on one criterion. For example, consider the Standard Cost
column in the Products table of the Northwind sample database:
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ӹӹ To use filter by selection
mouse
1. Click the first price in the list to highlight that particular field and then click the Selection command in
the Sort & Filter section of the Home ribbon. A small drop down menu will appear:

2. Click any of the options to sort the table of data based upon the criteria in the menu. For example, if you
click Less Than or Equal to $13.50, the table will Filter and show the less expensive products.

3. The Between option in the Selection command displays the Between Numbers dialogue box.
Enter the criteria for your search (between 5 and 10 for example) and click OK.
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Using Advanced Filter Options
Access offers a few other advanced filtering options that are accessible by clicking the – Advanced- command in the
Home ribbon:

Filter by Form
The Filter by Form command in Access is sort of like a small query. You can specify criteria that will be used to filter the
data like a query, but its use is more limited. Using Filter by Form is fast and easy if you have only a single value you are
looking for.
E.G.If you have a product ID but not a product name, Filter by Form can help.

ӹӹ To Filter by Form
mouse
1. Open the Products table in Datasheet view and select Filter By Form. Datasheet view will change to the
following view:

2. Each column you click inside will show a combo box. Select one of the values in the combo box to add it to
the Filter by Form operation:
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3. When you have chosen the criteria you wish to filter, click the Toggle Filter command in the ribbon.

4. The corresponding record(s) will be displayed:

> Apply now
redefine your future
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ӹӹ To remove the filter
mouse
1. Click on the toggle Filter button once to remove the filter
The filter by form feature is available in forms and queries we will look at more advanced uses of this tool later after
covering more criteria to allow us a broader scope for filtering our data.

Advanced Filter/Sort
Access uses filters like small queries.

ӹӹ To use advanced filter/sort
mouse
1. Clicking the Advanced Filter/Sort command will open a view very similar to query Design view:

2. Click and drag fields from the Products list to the lower half of the window. You can apply sort criteria
(Ascending, Descending) and enter search criteria such as a direct expression like the diagram above. You
can also add any sort of criteria you like including logical expressions like greater than (>) and less than (<).
3. Once you have entered the criteria, click Toggle Filter to show the results.
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Other Advanced Commands
Clear all Filters
This command will remove any filters currently applied to a particular object.
Load from Query
This command lets you load a filter from a query already stored in your database. Loading from a query is beyond the
scope of this manual.
Save as Query
This command lets you save certain types of filters you perform as a query to use later on. Saving queries is beyond the
scope of this manual.
Delete Tab

As you develop more filters for a particular table, you can use each one individually, like with an advanced sort for example:
Use the Delete tab command to remove the filters you no longer use.
Clear Grid
If you are performing a Filter by Form operation, use the Clear Grid command to reset all of the data columns back to
their original empty state. If a particular Filter by Form operation is not giving you the results you wanted or expected,
use this command to reset the form.

Changing Field Data Types
Access makes it very easy to change the data type of a certain field. Simply open the table containing the field you want
to change and pick a new Data Type from the appropriate row. However, you must take care when modifying a data type
in a table.
If the field is in a relationship with another table, or if the output of several forms and reports depend on the one field,
changing the data type can be a major task. You should examine the dependencies of an object before making a change.
Though we will explore table relationships more in this manual, relationships are one of the main characteristics of a
database.
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Object Dependencies

Picture a particular product listing in the Product table of a department store database. The item will contain a department
number. The store database will contain another table called Departments. Let’s say Department 1 is Women’s Wear and
Department 2 is Kitchen and Bath. Therefore, the two tables (Product and Department) are related because of common
and related information (Department Number).
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ӹӹ To examine object dependencies
mouse

1. Open a database object from the Navigation pane.
2. Click the Object Dependencies button in the Database Tools ribbon to see this pane:

3. Objects that depend on a particular object and all objects that a particular object depends on are visible by
selecting one of the two radio buttons at the top of the Object Dependencies pane.
Some tables may have many dependent objects. Modification of this table could end up being a long and tedious task. It
might even be faster in some instances to scrap the particular table altogether and design a new one with the modified data
type. If you feel you have to modify a data type, be careful and make sure it is absolutely necessary to do so. Remember
that you can always make a backup copy of the data base and/or a copy of the object itself before you make any big
changes, just to be safe.

Download free eBooks at bookboon.com

102

Access 2010: Part II

Queries

Section 5 Queries
By the end of this section you will be able to
•

Understand the use of queries

•

Use the query wizard

•

Format text and controls

•

Build Basic queries in Query design

•

Apply basic criteria

•

Multiple criteria

•

Use “And” “Or” Criteria

•

Build Calculations

•

Parameter Queries

•

Update Queries

•

Make table queries

•

Append queries

•

Delete Queries

Creating Queries
We now have come far enough to get to the real functionality of a database: using a query. Having large amounts of data
is fine, and having nice looking and well-designed forms is great, but if you can’t pose a question to the database and
find a result, there is not much use for a large list of data. In this lesson we will learn about queries and how they work.

What Is A Query?
A query is a question that is asked of a database control program about the data it contains. We specify what particular
fields we are interested in finding out, tell the database where to look for those fields, and specify any conditions under
which to search.
Queries are primarily built from tables, but Access gives you the ability to construct a query based on the results of another
query. Such ‘nested queries’ may require more computer memory and resources in order to execute but if constructed with
care, can save a lot of time, especially when dealing with very large databases. For the purposes of this manual, we will
keep things simple and stick to small and simple queries. Plus, the great thing about queries is that they are only questions
asked about data that is already there. If you get query results that are completely off the mark, no problem! The data is
untouched, so provided there is no design flaw in your database, only the query needs to be adjusted.
We are assuming at this point having covered the previous sections that you have built a database with more than one
table, set data types, descriptions, set field properties and primary keys then related the tables in a meaningful way and
entered data into the tables.
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Creating any object on a table will carry forward the field properties into the new objects if you build your database
objects before setting your field properties on your table you will have tedious work in replicating the same properties to
all objects. Ensure your tables are solid and all desired settings that you can set, have been.

Creating A Query With The Wizard
The query wizard is a quick way of creating a query and can help with certain types of query later on like unmatched
queries or finding duplicates.

Need help with your
dissertation?
Get in-depth feedback & advice from experts in your
topic area. Find out what you can do to improve
the quality of your dissertation!

Get Help Now

Go to www.helpmyassignment.co.uk for more info
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ӹӹ To use the query wizard
mouse
1. Click the Query Wizard command in the Create ribbon:
2. The Wizard launches, allowing you to select which type of query to build:

3. For the purposes of this manual, we will demonstrate a simple query that will retrieve the product ID,
product name, and price of every product in the Northwind sample database. This type of query is defined
as a select query, one that is used solely to retrieve information.
4. The next step of the Wizard is selecting which fields you want to use in your query.
5. In the Tables/Queries combo box, select Table: Products. Highlight ID and click the arrow (>)
to move the field to the Selected Fields list.
6. Repeat for Product Name and Standard Cost:
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7. The next page of the Wizard gives you the option to apply a few summary calculations to the field like
the maximum value, minimum value, and the average. However, we want to see all products, so leave the
Detail radio button selected:

8. The final page of the Wizard lets you name the query.You have the option to open the query right away or
modify the design in Design view:
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9. Click Finish to view the results of the query:

As you can see by the diagram, the query results are shown in what is essentially Datasheet view. The result of a query is
essentially a table complete with its own rows. you can actually use the results of a query to construct a table.(see make
table query later in this manual)

Using Query Design View To Modify a Query
As you gain more proficiency with Access, you will reach a point where using just the Query Wizard will not be sufficient
to get the results you are looking for. Therefore, you can use query Design view to modify any attribute of a query you like.
1. To access Design view after using a wizard, select the “Modify the query” design radio button:

or
2. If you wish to modify a query that already exists, double-click the query object in the Navigation Pane to
open it in Datasheet view.
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3. Use the View menu to select query Design view:
4. Either way, you will be shown the following view:

5. The table or tables that were used in the query are present at the top of the window, while the various
attributes that were specified during the design of a query are listed at the bottom. Note that the primary
key is shown in the table as a small key icon. You will also see six different row listings at the bottom of the
window.
•

The Field row will let you will see all of the fields that are available for use in the query (in this case the
attributes of the Products table).

•

The second row down is the Table row, where you can specify which table you want to use fields from.
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The Sort row lets you sort the results of the query in ascending or descending order (or no order at all, but
rather the order in which the query happened to find data first).

•

The Show checkbox will determine if the field will actually be shown in the query results. (If an item is
present in a query but does not have the Show checkbox marked off, it will still be considered in the query
but the data that was used to satisfy the query will not be shown.)

•

The Criteria row lets you enter a logical operator and a condition that any displayed data must satisfy.

6. We have seen the results of finding all products in the Products table. If we want to show only the items that
are more than $50 to purchase, we can enter the criteria ‘>50.’ This expression contains a logical operator
(greater than).
Other operators include less than (<), equal to (=), and not (!).
Query Design view also contains its own contextual tab. let’s take a quick look at what each section of commands does:

Brain power

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the
world’s wind turbines.
Up to 25 % of the generating costs relate to maintenance. These can be reduced dramatically thanks to our
systems for on-line condition monitoring and automatic
lubrication. We help make it more economical to create
cleaner, cheaper energy out of thin air.
By sharing our experience, expertise, and creativity,
industries can boost performance beyond expectations.
Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge
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Results

The Results section of the query Design ribbon lets you switch between views using the View menu and execute the query.
Query Type

This section of the ribbon allows you to modify properties of the query itself. Use these commands to make action queries
that will perform some operation on the data in your database.
Query Setup

Use these commands to modify attributes of a query as well as construct more elaborate search criteria.
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Show/Hide

The Show/Hide commands are used to view and modify different background attributes about the query and the data it
will display.

Using Queries
To execute a query, you simply have to double-click the query name in the Navigation Pane. The results will be displayed
in a new tab in Datasheet view. Since a query is not a bound object, you can delete a query without fear of deleting any
data in your tables. But be careful if you do delete a query, because there might be another query, form, or report that
uses the query to retrieve data for display to a user. If you eliminate the source query, the dependent object will not
function properly.

Basic Query use.
In the last section of this manual we will deal with queries. Queries are really the second most important objects in a
database (next to tables) because they have the ability to find information for you,Calculate and act as saved filters.

Review Of Queries
As a quick review, a query is a question that is asked of the data in a database. Although they are a structured piece
of computer code, they are no more difficult than merely asking a question like, “How much did salesperson X sell in
seafood products last year?” Queries primarily get their data from tables; however, a query can extract information from
another query as well.
Basic queries are called select queries; they search for information in your database based on criteria you specify. There
is another category of query called an action query that is designed to insert new data into a new table, delete old data
from a table, or append to data already in a database based on criteria.

Create a Query in Design View
Creating a Query from scratch is much the best way to create queries (apart from writing SQL) in Access and once you
have mastered the criteria and other aspects of queries you will probably find it quicker and more functional than using
the wizard.
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ӹӹ To create a query using Design view.
mouse

1. To start working with a new blank query, click the Query Design command: on the create ribbon.
2. Query Design view will open with the Show Table dialogue box.
3. Using this box, add as many tables and/or queries as you need to get the information relevant to your query.
Select each necessary object and click Add.

The source table will be added to the working space, with each field in the table listed. The primary key of the table
contains a small key icon beside it. When you have finished adding the objects relevant to your table, click -Close-.
4. To add fields to your query, simply click and drag the fields from the tables to the areas provided in The
design grid:
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Or
5. Double click the field in the table box you wish to add to the design grid and it will appear there.
Or
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6. In the empty field box of the design grid use the combo box to select the field you wish to have there.
Selecting the TblVehicle.* will output all fields to the query when you run it however you will be unable to add meaningful
criteria to a specific field. The same is said if you use the “*” option from the field list above.

7. You also have the ability to add certain search criteria, choose whether a field will be shown in the query
results, add additional search criteria, and more. We will explore more of Design view’s functionality later in
this section.
8. To execute the query, click the Run command in the Results section of the Query Tools - Design
ribbon:

9. The results will be displayed in Datasheet view:
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Sorting A Query
Once you have designed and executed a query, you will be shown results in Datasheet view. You can easily apply a sorting
scheme to query results. Consider the following query that was used to create a basic list of the products that Northwind
Traders sell:

ӹӹ To sort a query
mouse
1. Select a column of data by clicking on the name of the column (such as Product Name column header). You
can use the Sort & Filter section of the Home ribbon and click either the Sort Ascending or
Sort Descending commands as we did for a table.

2. The data in the column and the respective row will sort itself, for example, in Ascending or descending
order:
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3. Notice that a very small ‘up’ arrow is visible on the far right-hand end of the header. The second method of
sorting the data involves using the column header itself. Click the small pull-down arrow on the right-hand
side of the column header:

4. This pull-down menu provides much of the functionality that the Sort & Filter section provides. Simply
click the type of sort you want to apply. Access also gives you the ability to sort multiple columns of data at a
time.

ӹӹ To select multiple columns
Mouse
1. Select a single column as above.
2. Press and hold the Shift key, and click the column headers of any adjacent column.
3. Click the type of sort you want to apply from the options provided
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or
1. Return to design view using the design view button on the ribbon.
2. In the sort section of the design grid choose from the combo either ascending or descending under
the field of your choice

3. Run the query

Filtering a Query
Applying a filter to a query is a bit like querying a query, where you apply extra criteria to search results in order to narrow
down the results you need (or find that the query does not give you the results you thought you were going to get). The
filtering options are much the same as when we were filtering a table.
There are a few different ways to filter a query, so let’s talk about each.

Filter By Selection
Filtering by Selection is one of the easiest methods of filtering. Filter by Selection lets you select any field that was returned
by a query and filtering the query results based on that one field. For example, consider the following product query that
has already been filtered in alphabetical order:
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Notice how a few of the records returned have a Standard Cost of $0.00. If we want to find out how many other products
have not had a price assigned to them yet,
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ӹӹ To filter a Query
mouse
1. Click any instance of a $0.00 price to select the cell.
2. Click the pull-down arrow beside the Selection command in the Sort & Filter section:

3. The options listed in the pull-down menu allow you to apply logical filtering to the current selection. Since
we wish to find all of the items with the same price, select the first option. This will display all items meeting
the search criteria:

4. The results show in the picture on the next page.
5. To remove the filter click the toggle filter button in the sort & filter section of the ribbon
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Filter By Form
The next method of filtering is Filter by Form. The filter by form is the same process as in tables

ӹӹ To filter by form
mouse
1. Click the Filter by Form option found in the Advanced command in the sort & filter section
of the ribbon
2. Each column of data is replaced by a combo box, and each value in the combo box represents one instance
of every unique value in the column of data.

3. For example, click the combo box in the Standard Cost column:
4. Select one of the options in the list to only display the records which have the same standard cost as the
value you selected from the combo box. Pick a price from the column, such as 7.5,
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5. Click the Toggle Filter command ( ) in the Sort & Filter section of the Home ribbon:
6. The records show equally the filter conditions
7. Click the Toggle filter button a second time to remove the filter.

Advanced Filter
1. The final type of filter that Access can perform is an Advanced Filter; a manual filter using Design view.
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ӹӹ To use an advanced filter.
mouse

1. click the Advanced Filter/Sort option in the Advanced command:
2. It appears to be the design grid of a new query with the field list at the top and the design grid near the
bottom.
3. To perform an advanced filter operation, drag and drop the fields you want to consider from the table listing
to the design grid Field cells below as when you created a query.

4. Once you have added a field, you can specify how you want to sort the results (either ascending or
descending)

5. Set the criteria you want to use to filter with. For example, if you want to find all products over $10.00 in
price, drag the Standard Cost field into the Field cell, and then enter>10 into the Criteria cell:
6. Then, click the Toggle Filter command to filter the results
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We do not reinvent
the wheel we reinvent
light.
Fascinating lighting offers an infinite spectrum of
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markets provide both opportunities and challenges.
An environment in which your expertise is in high
demand. Enjoy the supportive working atmosphere
within our global group and benefit from international
career paths. Implement sustainable ideas in close
cooperation with other specialists and contribute to
influencing our future. Come and join us in reinventing
light every day.
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Hiding Fields
Access gives you the ability to hide and show different columns of data that may be necessary for filtering to work properly,
but are not necessary to see at all times.

ӹӹ To hide a Field.
Mouse
1. Right-click the column name and click Hide Fields:

ӹӹ To hide multiple Fields
mouse
1. Click one column header to highlight it.
2. Press and hold the Shift key, then click other adjacent columns to select them.
3. Right-click on any of the columns and click Hide Fields to make them disappear from view.

ӹӹ To show any hidden Fields
Mouse
1. Right click the header of any column still visible and click Unhide Fields:
2. The Unhide columns dialogue box will appear.
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3. Any hidden Fieldor Fieldsare indicated by the absence of a checkmark.
4. Check or uncheck to show or hide Fields.

Filtering Using “AND”/“OR” Operators
If you recall the Filter by Form section of this lesson, we went searching for all products costing $7.50.

Before you entered the $7.50 filter criteria, you might have noticed at the bottom of the Filter by Form window that there
are two tabs active: Look For and Or. If we wanted to search for products that cost $7.50 and products costing more
than $12.75 (or both), simply click the OR tab and enter more search criteria. As you add more OR searches, more OR
tabs will appear to make your search as specific or vague as you require.
When dealing with AND and OR operations, it is important to understand how they work on a logical level. These
operators require two pieces of input and produce one output, either true or false.
The AND operation is perhaps the easier to understand. Both conditions of AND must be satisfied in order to produce a
true result. For example, if you are making a cake, you need to have wet and dry ingredients mixed together. If you have
wet and no dry, or dry and no wet, or neither, you cannot make a cake.
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The OR operation is true as long as one condition is true. Let’s say you want to go and see a movie, but you will only go
if you have at least one friend to go with. You ask Alice and Bob if they want to come. If Alice and Bob can both come,
then you will go to the movies. If Alice can make it but Bob can’t, you will go, and vice versa. If neither Alice nor Bob
can go to the movies, you are not going to go either.
The best place to apply AND/OR operators directly is using Design view of a query (or query results). Let’s take a look
at the Design view for the simple products query we have been using:

CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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We would like to see the products that cost either $7.50 or greater than $12.75
To calculate this, specify the criteria in the Standard Cost field of the Products Query:
Each successive condition you enter in the column is called a where clause; you can add several where clauses to
help find more specific values. For example, if you own a company and lost the paper copy of an invoice, and you knew
that the total was $960, entering the =960 criteria will consider only those records that match. When designing queries
or filtering criteria that use AND operations, you essentially add more fields to a query and give each one a specific
criteria. For example, if you know that the missing invoice was $960 and sold by Salesperson A; enter the exact criteria
into Design view.
Should you not get the results you were looking for, don’t resort to merely trying different criteria that don’t make sense
to your situation. Think it out and ask why it isn’t working or giving you the results you thought you should be getting.
Another option for troubleshooting queries is to clear all of the criteria in your query and add it back one condition at a
time. Make sure that before adding another field, the results of the previous query are accurate for your purposes.

Using “OR” in filter by form
When you wish to find more than one value while filtering by form we do not need to type or we use the or tabs at the
bottom of the screen.

ӹӹ To use the OR operation in filter by form
mouse
1. Open or create a query
2. From the sort & filter section, advanced, select filter by form.
3. Select a value from the combo box of the field you wish to filter by
4. At the bottom of the screen click on the or tab a new or tab will appear and this screen will appear empty
of criteria.

5. Select another value from the drop down combo from the field you require.
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6. If you have several values you wish to filter for keep clicking the OR tab and selecting a new value each time.

Click the toggle filter button to view your results
7. Click the toggle filter button again to remove the filter

Using “AND” in filter by form
Using and in a filter by form operation is a similar operation to previous except this time we want the results to meet
more than one condition at the same time
Or means meeting one of the conditions.

And means meeting ALL the conditions.

ӹӹ To use the AND operation in filter by form
mouse
1. Open or create a query
2. From the sort & filter section, advanced, select filter by form.
3. Select a value or enter a criteria from the combo box of the field you wish to filter by
4. In another field choose another criteria

5. In the example shown the companies will have to be from the USA AND from Las Vegas
6. Click the toggle filter button to view your results
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7. Click the toggle filter button again to remove the filter

Select Queries and criteria
We have dabbled so far with creating basic queries and tested the use of filtering upon the data that is revealed but the
real use of queries are the saved advanced filters if you like because these saved filters (queries) can be used over again as
our data changes to show new records as the data evolves also since we will be learning to calculate within our queries

360°
thinking

we will be able to do so much more than using a filter. Later we will be building forms and reports based on the data
returned from these queries so the construction of these queries is important.

Create A Select Query With Single Criteria

.

To start you off slowly we will create a select query in design view and use a single criterion to filter out data. We will
then save that query. We will use the Northwind database

360°
thinking

.

360°
thinking

.
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ӹӹ To create a query
mouse

1. Create a query in design view (by clicking on the query design button on the create ribbon)
2. Add the products table by selecting it and clicking add
Or
1. Double click on the product table
2. Click close to close the show tabledialogue

3. Add the fields product name, standard cost and discontinued to the design grid using
one of the methods previously discussed.
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4. In the criteria row under standard cost enter the criteria >10
5. Sort the Standard cost field Ascending from the Sort Row.
6. Click on the save button (quick access toolbar)
7. Enter the name:
8. QryProductsGreaterThan10
9. Click ok to close the dialogue
10. Run the Query
11. Data should appear as on the next page.
12. Close the query window.
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Create A Select Query With Multiple Criteria
Using “OR”
The ANDOR operations are much more useful in a query and are entered differently remember a query is merely a saved
advanced filter and so we will move into proper query building from this section onwards

ӹӹ To create query using OR
mouse

1. Create a query in design view.
2. Add the purchase order details table
3. Close the show table dialogue
4. Add the fields product ID, quantity and posted to inventory.
5. The posted to inventory is a YES/no data type so enter no in the first criteria row.
6. In the next row down enter >10 in the cell.
7. Our criteria reads now:
8. Where our quantity is greater than 10 OR it has not been posted to inventory.
9. Sort the posted to inventory field descending.
10. Run the query.
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11. As you can see from the results for each record the quantity is either over 10 OR it has not been posted to
inventory.

Using “AND”
This time we will use the same criteria but we will use AND instead.
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ӹӹ To create query using OR
mouse

1. Create a query in design view.
2. Add the purchase order details table
3. Close the show table dialogue
4. Add the fields product ID, quantity and posted to inventory.
5. The posted to inventory is a YES/no data type so enter no in the first criteria row.
6. In the SAME row enter >10 in the cell.
7. Our criteria reads now:
8. Where our quantity is greater than 10 AND it has not been posted to inventory.
9. Sort the posted to inventory field descending.
10. Run the query.
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11. As you can see from the results for each record the quantity is Bothover 10 AND it has not been posted to
inventory.
12. The action of the And operation reduces the number of records that are returned and the or operation
increases the number of records returned.
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Text Criteria (“Like” Operator With Wildcards)
Text criteria usually involves exact strings of text that you are looking for as long as the text criteria are in speech marks
then you only have to worry about your spelling. We will try a query using the like operator for queries. Here are some
Critirion Wildcards
*

Matches any number of characters. It can be used as the first
or last character in the character string.

Wh* finds what, white, where and why (plus
many others)

?

Matches any single alphabetic character.

B?ll finds ball, bell, and bill and bull

[]

Matches any single character within the brackets.

B[ae]ll finds ball and bell but not bill

!

Matches any character not in the brackets.

B[!ae]ll finds bill and bull but not bell

-

Matches any one of a range of characters. You must specify the
range in ascending order (a to z, not z to a).

B[a-c]d finds bad, bbd, and bcd

We will now try a query using some text criteria and a wildcard. We would like to find from the employees table all the
sales representatives.

Look at the plain data above.There are many people in sales such as the coordinator manager and vice president. We
could have used
Like “sales*”
But this would only show all the others (apart from the vice president) so since we want the representatives we Can use
either:
“Sales Representative” or Like “*representative” or Like “*rep*”
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ӹӹ To build a query with text criteria.
mouse

1. Build a query in design view.
2. Add the employees table to the query
3. Add the first name, last name and job title fields to the design grid.

4. Close the show table dialogue.
5. Enter one of the like criteria as mentioned above into the design grid
6. Run the query.
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Other Criteria
Here is a list of other characters that may help you find the data you are looking for we will test a few of these.
Reserved
characters

Explanation

Example

Includes records with

“”

Used around text

“Bananas”

Bananas

##

Used around dates

#16/01/06#

Date is 16/01/06

<

Less than

<300

Any number less than (but not
including) 300

>

Greater than

>300

Any number greater than (but not
including) 300

>=

Greater than or equal
to

>=300

Any number that is 300 or above

<=

Less than or equal to

<=300

Any number that is 300 or below

Null

No value in the field

Is null

Any record where a specified field
is empty

Not

Excluding values

Not “jones”

Do not include any records that
contain the word jones

In

Select records in

In (“london,
“birmingham”, “bristol”)

Records that contain london,
birmingham or bristol

Or

Meets either criteria

“london” or
“birmingham”

Find records that contain either
london or birmingham

And

Meets both criteria

>=21 and <60

Find records between 20 and 60

Between

Between to numbers
or dates

Between 300 and 1000

Any records that fall between 300
and 1000

Date()

Today’s date

=date()

Display the current date

#

Matches any single
numeric character.

1#3

finds 103, 113, 123

Using “OR” for multiple values (2nd method)
Another way of using OR is to use the text itself in a criteria cell.

ӹӹ To use OR
mouse
1. Build a query in design view.
2. Add the employees table to the query
3. Add the first name, last name and job title fields to the design grid.
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4. In the criteria cell in the first name field enter the following syntax
Like “A*” Or Like “M*”

5. When this criteria is entered run the query.
6. The results are on the next page.
7. As you can see all those people whose first name start with A or M are now shown in the results
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Using “AND” for multiple values (2nd method)
Another way of using AND is to use the text itself in a criteria cell.

ӹӹ To use AND
mouse
1. Build a query in design view.
2. Add the Products table to the query
3. Add the Product ID, Product name and standard cost fields to the design grid.
4. In the criteria cell in the standard cost field enter the following syntax
>=10 And <=20
5. Run the query the results are shown below.

6. The records returned are greater or equal to ten and less than or equal to 20

Using “IS NULL” and “NOT”
The IS null command will return records where the value in the column has not been entered where it is NULL. In
conjunction with NOT we can find records that are NOT NULL(IS not null) or not empty. This can be useful in
an address list where you want a list of people to phone and you want the list to return only those with phone numbers.
Make a copy of the northwind database and open the copy.
Open the customers table and delete the phone numbers from a number of customers. As in the following picture and
we are ready to start.
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First we will find those without phone numbers

ӹӹ To use NULL and NOT
mouse
1. Build a query in design view.

2. Add the Customers table to the query
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3. Add the first name, last name and business phone field to the design grid.
4. In the criteria for the business phone field enter is null.
5. Run the query

6. As you can see only those without phone numbers are displayedNow we will find only those with phone
numbers
7. Return to design view and change the criteria to is not null.

8. Run the query the data should show as follows.
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“BETWEEN” and “AND”
When working with numbers, currency or dates you may wish to bring back a range of figures from your data. We have
done this using greater than and less than but this can be a little clumsy the between and and reserved words within
access make life much simpler it is pointed out that they are inclusive of any figures you enter so entering equals is no
longer necessary.

ӹӹ To use BETWEEN and AND
mouse
1. Build a query in design view.
2. Add the Products table to the query
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3. Add the Product ID, Product name and standard cost fields to the design grid.
4. Enter the criteria:
Between 2 And 9
5. Run the query.
6. Sort the standard cost column ascending
7. As you can see all values within the range specified are returned Including those priced at 2 and 9

Date Range Criteria
We can use this between and and criteria to help us with date ranges we will build a query first looking for a specific
date and then between a range of dates. The hash key is used to surround a date so access can understand what it is.

Download free eBooks at bookboon.com

146

Access 2010: Part II

Queries

ӹӹ To query a specific date
mouse

1. Build a query in design view.
2. Add the orders table to the query
3. Add the fields customer ID, Order date and ship city
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4. In the order date criteria cell enter the following criteria.
#24/03/2006#
5. Run the query and the following records should be returned.

ӹӹ To return a range of dates
mouse
6. Return to design view and change the criteria to a date range enter
Between #01/04/2006# And #30/04/2006#
7. The between and and as before work the same way as >= and <= to return a range of dates the
above criteria should show all the orders for April 2006.

Using Multiple Tables In Queries
When you are extracting data from your database you will need to pull information from various tables to make sense
of the data. In one table like the orders table we have just seen it may contain the customer ID field but that will not pull
out information from the company similarly it may contain the Product ID but nothing else about the product we will
need to create queries based on more than one table to bring out any meaningful data especially if we have to build a
report on it later. Let us find out some extra information from our database based on more than one table. It is important
that the tables are related.
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Query across 3 tables
We will build a query across 3 tables in the northwind database and pull out the related information we will then save
the query for later use in a report

ӹӹ To build a Query across multiple tables
mouse
1. Build a query in design view.
2. We will add the Shippers table, the Orders table and the Customers table to the Query.
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3. Add the fields as shown in the picture above please note which table they are from from the table row. For
instance the first name, last name and company fields are from the customers table not the
shippers table and the the last company name field is from the shippers. Only the order date comes from
the orders table
4. Please note the relationship joins we will look at these in more depth later but they show a definite
relationship between the tables.
5. Sort the last name field ascending
6. The is not null criteria is entered in the shippers.company field as a number of orders have not
yet been assigned to a ship (order has not gone through yet)
7. When we run this query we will know who is to receive an order on a specific date and what ship it will be
on. If necessary adjust the column widths in datasheet view. It should look like it does below.There should be
43 records.
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8. Go back to design view and set the criteria to show Aprils orders it should be on the same row as is not
null
Between #01/04/2006# And #30/04/2006#

9. The data should appear as below

10. Save the query as QryShippedOrdersInApril and close it

The Zoom Window and Concatenation
The zoom window is a very useful tool as you have seen in the previous exercises it can be difficult to enter long strings
of criteria into one of those small columns in the design grid the zoom window gives you the space to enter it easily plus
we can make the font larger so it is easier to read making mistakes in syntax less likely.
Concatenation is where we join the data from two fields together such as last name and first name to give a full name
field this can be useful when creating reports. Concatenating fields is classified as an expression.

ӹӹ To use the zoom window and concatenate
1. Build a query in design view.
2. Add the customers table
3. Form the table add the first name and last name fields to the design grid and click in the field cell of the
third column.
4. Hold down the shift key and press F2 to open the zoom window

Download free eBooks at bookboon.com

152

Access 2010: Part II

Queries

5. Click on the font button to open the font dialogue box and enlarge the font to a comfortable size (say 12
or 14) click on OK to close the fontdialogue

.
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6. Fields when written in expressions should be enclosed in square brackets and spelling is very important even
a space in the wrong place will cause an error message and the expression will be invalid. (This is why earlier
when we were building tables you were advised not to leave any spaces within a fieldname.)
7. We need to name the new calculated field we are creating so we do that first followed by a colon
FullName:
8. Then we enter the first part of our expression we want to join the first name to the last name so we
enter the first name field in square brackets, since our first name field has a space we must enter it exactly
the same way.
FullName:[First Name]
9. Now we need to use the concatenate symbol which is the ampersand (&)
FullName:[First Name]&
10. Now if we just join both fields together the text will run into one string of text so we need to join the first
name to a space and since this is text we must show that by enclosing it in speech marks.
FullName:[First Name]&” “
11. Then we must use the concatenate symbol again to specify this piece of text is to be joined to something else.
FullName:[First Name]&” “&
12. Finally we add theFinal field it is to be joined to, the last name field.
FullName:[First Name]&” “&[Last Name]
•

Please note we have entered no extra characters in our expression.

13. Click on OK to enter our Expression into the field area of the design grid and press return for access to
accept it. As you can see the syntax is far longer than the width of the column and although you may adjust
the width of the column the speech marks are difficult to see. If you need to edit the concatenated field select
it and press shift + F2
14. Run the query to see the results.
15. Adjust column widths and sort by FullName field
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16. Save as QryFullName and close the query

Expression Builder
Just to explain the parts of the expression builder it is accessed by clicking on the builder button on the query setup group
of the query design ribbon.
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Calculated Fields
We can calculate fields within Access either by typing them in manually as we did with the concatenation or we can use
the expression builder which allows us the access to many different functions available in access. We will now
calculate a field using the expression builder although this is used as an example there are many other uses for it
and as you become more proficient with it, your mastery over access will increase the Expression builder is also
available in forms and reports.
Looking again at the northwind database we will look at the order details table and the products table and calculate
the subtotal of each order detail. Later we will total this.

ӹӹ To build a calculation
mouse
1. Create a query in design view
2. Add the order details and the product tables to the grid
3. Add the quantity and unit price fields from the order details table
4. Add the standard cost and the product name from the product table.
5. In the fifth column click in the field cell.
6. Save the Query as “QryCalculate1” (this allows us to see the fields from this query in the expression builder.)
7. On the Query setup group of the ribbon click on builder the expression builder dialogue box will
open.
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8. Select the Qrycalculate1 in the far left box if it is not selected to see the fields available in the centre box.
9. Now if you double click on quantity the field name should appear In the topbox it will be preceded by
<<expr>>
•

We cannot change font size here as we did with zoom so care must be taken when typing.

10. In the topmost box we must enter a new fieldname for the expression select the <<expr>>and delete it and
type:
CostPerDetail:

11. Now we need to multiply the quantity.
12. In the bottom left box select operators.
13. In the middle box select arithmetic
14. In the right box double-click on the asterisk it then should appear after quantity.
15. Select the QryCalculate1 option on the far left again.
16. Double click on the Unit Price field in the centre of the builder. It should appear after the asterisk.

17. Click on OK to close the builder and press enterfor access to accept you calculated field.
18. Sort by CostPerDetail ascending
19. Run the query
Download free eBooks at bookboon.com

157

Access 2010: Part II

Queries

20. Adjust column sizes and save the changes to the query.there should be 58 records the first few sould appear
as in the following image
21. Do not close the query.

Formatting a Field
As you can see from the records our calculation has worked but it is not showing currency as we would like it to be. This
next section shows how we can format our query fields as we did with our tables.

ӹӹ To format a field in a Query
mouse
1. Open the previous query in design view
2. Click in the CostPerDetail Field.
3. Click on the property sheet button in the show/hide group on the design ribbon. A pane opens
up to the right of the window
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4. In the format section choose the currency format.
5. Set decimal places to 2
6. Enter the caption “Cost Per Detail” the as you would with a table.
7. Close the property sheet by clicking on the property sheet buttoon the ribbon.
8. Save the changes
9. Run the query
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10. The cost per detail should now be in currency and the field label should have spaces. (Far Right)
11. Close the query QryCalculate1

Unique Values
If you want to view records that contain unique values in selected fields, then in the query properties property sheet, set
the unique values property to yes before you run the query.
•

You can’t update records in a query datasheet when the unique values property is set to yes.

We are going to see what products are on order within the .Order details table certain items are on order more than once
and some not at all we want just a list of the products ordered not the duplicate ones.

ӹӹ To show unique values
1. Create a new query in design view
2. From the show table dialogue box add the Order details and products tables
3. Close the show Table dialogue box
4. Add the field Product Name to the design grid
5. Sort the field ascending
6. Run the query
7. Make a note of the record number returned notice the duplicate values
8. Return to design view
9. Show the Property sheet.
10. Instead of clicking on or near the field in the grid click on the table area of the grid (the top part of the
window) that contains the tables we added the property sheet values should change to those in the picture.
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11. Set the unique values option to yes
12. Run the query
13. Note the number of records now displayed Notice that there are now no duplicate records.
14. Save the query as QryUniqueValues and Close the Query.

Building queries on queries
Aggregate Functions (Total Row)
Aggregate functions mean the figures within a table or query are grouped and a function is applied to them such as the
sum function or average function. This is very useful for building reports later on. We are going to build an aggregate
function now and will build this on a query.
Aggregate functions can obviously be built directly onto table but this sectionis going to cover two aspects of queries. We
are going to query one query with another query.

ӹӹ To use aggregate functions
mouse
1. Create a new query in design view.
2. In the show tables dialogue click on the queries tab
3. Add the Qrycalculate1 query to the grid.

4. Close the Show tabledialogue
5. Add the product name and CostPerDetail Field to the grid.
6. Sort the product name field - Ascending and run the query.

Download free eBooks at bookboon.com

161

Access 2010: Part II

Queries

7. As you can see from the results because the previous query shows the same product many times you were
only getting a subtotal of each of the products. We will now get a true total value for each product.
8. Go back to design view
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9. Click on the totals button in the Show/hide group of the design toolbar.

10. In the design grid a new row will appear called totals and along that row below the field names it should
say group by.

11. in the CostPerDetail field group by cell click on the drop down arrow and select sum.

12. This means that the values in the product name will be grouped together where they are the same and the
CostPerDetail will be summed together.
13. Click in the CostPerDetail field.
14. Click on the property sheet button on the show/hide group of the design ribbon.
15. Enter a caption of “Total Sales”
16. Set the format to currency and set decimal places to 2.
17. Run the Query again and compare your data you now have a total value for each of the products.
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18. Save the query as QryCalculate2 and close the query

Parameter Queries
When running a query, you may not know what criteria to put in at the time or you may want to put in different criteria
at different times your needs for the query may change.
In this situation, you can place a holder in the criteria field in lieu of the actual criteria. This is called a parameter query.
When the query is actually run, the criteria will then be requested. The primary advantage of using a parameter query lies in
being able to use the same query for many different possibilities of criteria, such as shifting dates or different product lines.

Single Textual Parameter
All of the criteria we have used so far can be used when building a parameter query the only difference is, is that the actual
values you would enter into the criteria (not the operators) would be entered when the parameter query is actually run.

ӹӹ To create a single parameter
mouse
1. Create a query in design view.
2. Add the Customers table to the grid.
3. Close the show table dialog
4. Add the first name, last name and state/province fields to the grid
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5. Sort the state/province field ascending.
6. Run the query and check the data.
7. Return to design view
8. In the criteria section of the state/province field open the zoom window (Shift +F2)
9. In the zoom window enter the following syntax.

Click ok and press return for access to accept the parameter.
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Run the query you should be presented with a small dialog asking you for your criteria enter CA and click OK

10. The data should then appear showing records that match your criteria.
11. Try it several times with different criteria.
12. Save the query as QryPara1 and close the query.

Parameters with 2 conditions
We will now attempt a parameter query with more than one condition its basically the same but we will use operators like
we did for select queries the only difference is that instead of the criteria in the expression we will use parameter questions.

ӹӹ To create a query with 2 parameter conditions.
mouse
1. Create a query in design view
2. Add the Orders and Customers tables to the grid
3. Close the show table dialogue.
4. Form the Customers table add the Company field
5. From the orders table add the Order Date field
6. Sort the company field ascending.
7. In the criteria section of the order date field open the zoom window (Shift + F2).
8. Enter the following Syntax.

9. As you can see there are two parameter conditions to enter now to return a range of dates.
10. Close the zoom window and press return for access to accept the criteria.
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11. Save the query as QryPara2.
12. Run the query enter dates for May 2006
13. When the first dialog appears enter the start day for May press return or click ok.
14. When the second dialogue appears enter the end date for May and close the dialogue.
15. The records returned should be as shown.

Multiple Parameters
Some queries may need more than one parameter across more than one field since each parameter will ask a different
question we just need to ask the right questions. We will use the same query as above and put a second parameter on
the company field since we don’t want to have to keep typing in the word company we will have to be creative with the
syntax using what we already know.

ӹӹ To create a query with multiple parameters
mouse
1. In the query QryPara2 go to design view
2. In the design grid click in the criteria section of the company field.
3. Open the zoom window and enter the following syntax
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Remember we do not want to keep entering the text “company” so we will have to join that or concatenate it to the value
we will enter in the parameter remember there is a space after the word company and we must include that in the speech
marks after the word company. The ampersand (&) is the operator to concatenate text.
4. When the syntax has been entered close the zoom window and press return for access to accept the syntax.

5. Run the query you now have three values to enter for the company letter enter the letter “J”. and for the
dates enter the month of May agin as before the records should show as follows.
6. Know we know what company J has purchased in May
•

By using the like operator along with one or more wildcards in a parameter query, you can quickly and
easily display query results from “inexact” criteria, that is, part of the field’s contents, or a common pattern.
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Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge

Download free eBooks at bookboon.com

168

Click on the ad to read more

Access 2010: Part II

Queries

Control The Parameter Order
To change the order in which enter parameter value dialogue boxes are displayed, use the parameters
dialogue box.
7. To display the query parameters dialog box, the parameters button from the show/hide group.

8. In the parameter column, enter each of the parameters in the order required to run (you don’t need to put
the square brackets around them.)
9. In the data type column, select from the value list the type of data to be entered.
10. Any parameter that is entered into the query design grid but not entered into the query parameters dialog
box is displayed after the last parameter in the query parameters dialog box has been displayed.

Other Parameter Criteria Options
We could use the like criteria on fields with long strings of text like data from the products table for example.
Like[enter first name of product]&”*”
Like”*”&[enter last name of product]
Like”*”&[enter any part of product name]&”*”

Crosstab Query
What Is A Crosstab Query
A crosstab query is a query that calculates a sum, average, count, or other type of total on records, and then groups the result
by two types of information: one down the left side of the datasheet and the other across the top. A little like a Pivot table.
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Creating a Crosstab
Now suppose that you want to review product subtotals, but you also want to aggregate by month, so that each row shows
subtotals for a product, and each column shows product subtotals for a month. To show subtotals for a product and to
show product subtotals for a month, use a crosstab query
We will compound previous lessons and build a calculation, format, save, aggregate totals AND create a crosstab all in
one Query
•

You cannot create a Web query that is a crosstab query.

ӹӹ To create a Calculation
mouse
1. On the Create tab, in the Queries group, click Query Design.
2. In the Show Table dialog box, on the Tables tab, double-click Order Details.
3. Close the Show Table dialog box.
4. In the Order Details table, double-click Product ID to add this field to the first column of the query
design grid.
5. In the second column of the grid, right-click the Field row, and then open the Zoom window.(Shift+
F2)

6. In the Zoom box, type the following:
Subtotal: ([Quantity]*[Unit Price])-([Quantity]*[Unit Price]*[Discount])
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7. Close the zoom window
8. While in the subtotal field Show the property sheet
9. Set the format to currency and 2 decimal places.
10. Sort the product ID Ascending
11. Save the query as QryProductSubtotal
12. Run the Query to see the subtotals

ӹӹ To show totals in datasheet view
mouse
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1. While in datasheet view in the Home rib bon, Records group, click Totals.
•

A new row appears at the bottom of the datasheet, with the word Total in the first column.

2. Click the cell in the last row of the datasheet named Total under the product Id field

•

Note that an arrow appears in the cell.

3. Click the arrow to view the available aggregate functions.
•

Because the column contains text data, there are only two choices: None and Count.

4. Select Count.
•

The content of the cell changes from Total to a count of the column values.

5. Click the adjoining cell under the subtotals (the second column).
•

Note that an arrow appears in the cell.

6. Click the arrow, and then click Sum.
•

The field displays a sum of the column values.

7. Go back to design view
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ӹӹ To create aggregate function
mouse

1. On the Design tab, in the Show/Hide group, click Totals.
2. The Totals row is displayed in the query design grid.
•

Although they have similar names, the Totals row in the design grid and the Total row in a datasheet
are not the same:

3. In the second column of the design grid (Subtotals), in the Total row, select Sum from the drop-down
list.
4. Save the query and run it.
5. The products have aggregated and now the subtotals column shows those aggregated totals.
6. Return to design View
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ӹӹ To create a crosstab
mouse

1. In the Query Setup group, click Show Table.
2. In the Show Table dialog box, double-click Orders, to add this table to the design grid then click
Close.
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3. On the Design tab, in the Query Type group, click Crosstab.
4. In the design grid, the Show row is hidden, and the Crosstab row is displayed.

5. In the third column of the design grid, right-click the Field row, and then click Zoom on the shortcut
menu. The Zoom box opens.
6. In the Zoom box, type the following:
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Month: “Month “ & DatePart(“m”, [Order Date])

7. Click OK to close the Zoom Box
8. In the Crosstab row, select the following values from the drop-down list:
9. Row Heading for the first column,
10. Value for the second column,
11. Column Heading for the third column.
12. On the Design tab, in the Results group, click Run.
13. The query runs, and then displays product subtotals, aggregated by month.
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14. Press CTRL+S to save the query and close.

Action Queries
Be warned that if you try to run an action query on a table which is opened by several users then the query will fail due
to locking errors.
Action queries allow the user to quickly and easily make changes to the data and transfer it between tables. There are
four types they are:

Update query
Append query
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Delete query
Make table query
Before running an action query you can view the records that will be affected by the query by looking at the query in
datasheet view. Before making a selection as to the type of query you may want to use
In the use of the Action Queries we will continue to use the northwind database.

Make table Query
You can use a make-table query to create a new table from data that is stored in other tables.
For example, suppose that you want to send data for Chicago orders to a Chicago business partner who uses Access to
prepare reports. Instead of sending all your order data, you want to restrict the data that you send to data specific to
Chicago orders.
You can build a select query that contains Chicago order data, and then use the select query to create the new table by
using the following procedure:
•

To run a make-table query, you may need to enable the database content by using the Message Bar, which
appears beneath the Ribbon if the database is untrusted when you open it.

•

If your database is in a trusted location, the Message Bar does not appear and enabling the content is
unnecessary.

ӹӹ To create and run a make table query.
mouse

1. On the Create tab, in the Queries group, click Query Design.
2. In the Show Table dialog box, double-click Order Details and Orders.
3. Close the Show Table dialog box.
4. In the Orders table, double-click Customer ID and Ship City to add these fields to the design grid.
5. In the Order Details table, double-click Order ID, Product ID, Quantity, Unit Price, and
Discount to add these fields to the design grid.
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6. In the Ship City column of the design grid, clear the box in the Show row.
7. See next page for the design Layout.

8. In the Criteria row, type Chicagoin speech marks
9. Verify the query results before you use them to create the table.

10. On the Design tab, in the Results group, click Run.
11. Press CTRL+S to save the queryasQryChicagoOrders,
12. Click OKto close the dialogue
13. Return to Design View.
14. On the Design tab, in the Query Type group, click Make Table.
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15. The Make Table dialog box appears.

16. In the Make Table dialog box, in the Table Name box, type TblChicagoOrders, and then click OK.
17. On the Design tab, in the Results group, click Run.
18. In the confirmation dialogue box, click Yes to confirm.

19. The new table is created, and the table appears in the Navigation Pane.
•

If there is already a table that has the name that you specified, that table is deleted before the query runs.

1. On the Design tab, in the Results group, click Run again
2. Because the TblChicagoOrders table exists, a warning dialog box appears.
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3. Click No to cancel the action and to dismiss the dialog box.

Append Query
An append query is similar to the make table query except the results are appended to an existing table
You can use an append query to retrieve data from one or more tables and add that data to another table.
Suppose that you created a table to share with a Chicago business associate, but you realize that the associate also works
with clients in the Milwaukee area. You want to add rows that contain Milwaukee area data to the table before you share
the table with your associate.

ӹӹ To create and use an append query
mouse
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1. Open the query named “QryChicagoOrders” in Design view.
2. Go to the file tab and select save object as
3. In the dialogue enter the name “QryMilwaukeeOrders” and click OK

4. In the design grid, in the Criteria row of the Ship City column, delete ‘Chicago’, and then type
‘Milwaukee’.

5. On the Design tab, in the Query Type group, click Append. The Append dialog box opens.
6. In the Append dialog box, click the arrow in the Table Name box, and then select TblChicagoOrders
from the drop-down list.
7. Click OK.
8. The Append dialog box closes. In the design grid, the Show row disappears, and the Append To row
appears.

9. In the Append To row, select the appropriate field for each column that you wish to append to.
10. In this example, the Append To row values should match the Field row values, but that is not required
for append queries to work.
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11. On the Design tab, in the Results group, click Run.
12. A dialogue will appear confirming the append procedure.

13. Click yes
14. Save the changes to the Query and close.
15. Open TblChicagoOrders to see the appended data
•

Please remember this appended data shows the Customer ID and the Product ID and the table would need
to be related to the customers table and the products table to match the ID’s with the correct information.
Or Have it updated using an Update Query
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Update Query
You can use an update query to change the data in your tables, and you can use an update query to enter criteria to
specify which rows should be updated. An update query provides you an opportunity to review the updated data before
you perform the update.
•

An action query cannot be undone. You should consider making a backup of any tables that you will update
by using an update query.

In the previous example, you appended rows to the TblChicagoOrders table. In the TblChicagoOrders table, the Product
ID field shows the numeric Product ID. To make the data more useful for reports, you may want to replace the product
IDs with product names. To replace the product IDs, you must first change the data type of the Product ID field of the
Chicago Orders table from Number to Text, so that the Product ID field can accept product names.
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ӹӹ To change Datatype in the table
mouse
1. Open the TblChicagoOrders table in Design View
2. Change the product ID to the text data type and the field size (properties) to 100

3. Save and close the Table

ӹӹ To update the values in the TblChicagoOrders
mouse
1. On the Create tab, in the Queries group, click Query Design.
2. In the Show Table dialog box, double-click “TblChicagoOrders” and “Products”.
3. Close the Show Table dialog box.
4. On the Design tab, in the Query Type group, click Update.
•

In the design grid, the Sort and Show rows disappear, and the Update To row appears.

5. In the TblChicagoOrders table, double-click Product ID to add this field to the design grid.
6. In the design grid, in the Update To row of the Product ID column, type the following:
[Products].[Product Name]
•

You can use an update query to delete field values by using an empty string (“”) or NULL in the Update To
row.
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7. In the Criteria row, type or paste the following:
[Product ID] Like ([Products].[ID])
•

The Like keyword is necessary because the fields that you are comparing contain different data types
(Product ID is text data, ID is numeric data).

8. You can review which values will be changed by an update query by viewing the query in Datasheet view.
On the Design tab, in the Results group, click View, and then click Datasheet View.
9. The query returns a list of Product IDs that will be updated.
10. On the Design tab, in the Results group, click Run. A dialog will appear confirming the update.

11. Save the Query as QryUpdateProductID and close the query
12. Open the TblChicagoOrders table, you will see that the numeric values in the Product ID field have been
replaced by the product names from the Products table.
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13. Adjust column widths where necessary and save the changes to the table.
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Delete Query
You can use a delete query to delete data from your tables, and you can use a delete query to enter criteria to specify
which rows should be deleted. A delete query provides you an opportunity to review the rows that will be deleted before
you perform the deletion.
Suppose that you are preparing to send the “TblChicagoOrders” table to your Chicago business associate, and you notice
that some of the rows contain a number of empty fields. You would like to remove these rows that contain empty fields
before you send the table. You could just open the table and delete the rows manually, but you might find it helpful to
use a delete query if there are more than a few rows that you want to delete and you have clear criteria for which rows
should be deleted.
You can use a query to delete rows in the Chicago Orders table that do not have a value for Order ID by using the
following procedure:

ӹӹ To delete records
mouse

1. On the Create tab, in the Queries group, click Query Design.
2. In the Show Table dialog box, double-click TblChicagoOrders.
3. Close the Show Table dialog box.
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4. In the TblChicagoOrders table, double-click Order ID to add it to the grid.
5. In the design grid, in the Criteria row of the Order ID column, type Is Null.
6. Click view datasheet to see which records will be deleted
7. Return to design view
8. Save the query as QryDeleteEmptyOrders
9. On the Design tab, in the Query Type group, click Delete.
In the design grid, the Sort and Show rows disappear, and the Delete row appears.
10. On the Design tab, in the Results group, click Run.
11. A dialog will appear confirming the running of this query.

12. Click yes and another dialog will appear informing you of what is about to happen.
•

Remember since deleting a record cannot be undone these dialogs give you every chance to change your
mind.

13. Click yes to confirm the deletion
14. Open the Table TblChicagoOrders to see that the records have been deleted
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Back Up Your Database
Back up your database before you delete records. You cannot reverse or undo a delete operation. The only way to recover
deleted records is to restore them from a backup. A delete operation might also delete records in related tables, so it is
best to back up the entire database before starting the operation.

ӹӹ To Back up a database
mouse
1. Click on the File tab, go to save & Publishclick Back Up Database and then click Save as
2. The Save As dialog box appears, and Access appends the current date to the file name. Access creates the
following type of file name: Northwind -_2010-04-29.accdb.
3. Accept the default name and location, or select another name or location, and then click Save.
4. Access closes the original file, creates a backup, and then reopens the original file.
•

To revert to a backup, close and rename the original file so that the backup copy can use the name of the
original version. Assign the name of the original version to the backup copy, and open it in Access.

5. Now we may proceed with finding and deleting our duplicates.
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Query to locate Unmatched Records
Sometimes you may want to compare two tables and identify records in one of the tables that have no corresponding
records in the other table. The easiest way to identify these records is by using the Find Unmatched Query Wizard. After
the wizard builds your query, you can modify the query’s design to add or remove fields, or to add joins between the two
tables (to indicate fields whose values should match). You can also create your own query to find unmatched records,
without using the wizard.
We want to see a list of Northwind 2010 products that have never been sold,

ӹӹ To create an unmatched query with a wizard
mouse
1. On the Create tab, in the Queries group, click Query Wizard.
2. In the New Query dialog box, double-click Find Unmatched Query Wizard.

3. On the first page of the wizard, select the table that has unmatched records, select the “Products” tableand
then click Next.

Download free eBooks at bookboon.com

192

Access 2010: Part II

Queries

We will turn your CV into
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com

Download free eBooks at bookboon.com

193

Click on the ad to read more

Access 2010: Part II

Queries

4. Select the table that is related, in our case the “Order Details” table and then click Next.

5. Select the fields that relate the tables, click < = >,. Select “ID” from the “Products” table and “Product ID”
from the “Order Details” table.

6. Verify that the correct fields are matched by checking the text in the Matching fields box and then
click Next..
•

The ID and the Product ID fields may already be selected because of existing relationships built in to the
template.

•

You can choose only one field from each table
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7. Double-click the fields that you want to see from the first table, select the “ID” and “Product Name” fields
and then click Next.
8. This page allows us to either view the results or to modify the design of our query, click View the
results.

9.

Name the query QryProductsNotSold, and then click Finish.
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10. You may want to modify your query’s design to add other criteria, to change the sort order, or to add or to
remove fields.
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Finding Duplicates Query
One of the primary reasons for using a relational database is to avoid duplicate data. However, as databases age, they
often acquire duplicate values, especially when multiple users enter data. Typically, eliminating duplicate data saves money
on storage and keeps your data more accurate. In turn, that accuracy can help you make better business decisions. For
example, if you enter a sales order more than once, the customer might receive unneeded goods, and the redundancy can
cost you money in increased shipping and accounting costs.
Before you take action to identify and delete duplicate records, remember that you need to rely on your knowledge of the
data. Unlike the process of designing a database, you cannot follow a set of specific rules or procedures to find and delete
duplicate records accurately. Remember one fact as you proceed: database queries can return what seem to be duplicate
records, but in reality, those results are valid data. The apparent duplication usually happens when you do not include
fields in the query that uniquely identify each record.
In some situations, such as when you look at data returned by a query, you might see what appear to be duplicate records,
even though the underlying tables seem to contain only unique records. Problems can arise when your view does not
include fields that uniquely identify a record
If you choose to delete your duplicate records, you must first deal with any existing table relationships. Typically, most
databases use one-to-many relationships. For example, you might have a small number of customers, but each customer
places many orders. As a result, the table of customer data resides on the “one” side of the relationship, and the order data
resides on the “many” side of the relationship.
Remember this rule as you proceed: if the data that you want to delete resides on the “many” side of a relationship, you
can delete data without taking additional steps. However, if the data resides on the “one” side, you must set a property in
the relationship, or Access will prevent the deletion.
For this Query I am using a separate database not the northwind.
I have created a table called TblCustomers and added the following data:
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Company Name

Contact Name

Address

City

Postal
Code

Phone

Baldwin Museum
of Science

Josh Barnhill

1 Main St.

New York

12345

(505) 555-2122

Blue Yonder
Airlines

Waleed Heloo

52 1st St.

Boston

23456

(104) 555-2123

Coho Winery

Pica Guido

3122 75th Ave.
S.W.

Seattle

34567

(206) 555-2124

Contoso
Pharmaceuticals

Jean Philippe Bagel

1 Contoso Blvd.

London

NS1 EW2

(171) 555-2125

Fourth Coffee

Julian Price

Calle Smith 2

Mexico City

56789

(7) 555-2126

Coho Winery

Christine Hughes

3122 75th St. S.

Seattle

34567

(206) 555-2125

Humongous
Insurance

Steve Riley

67 Big St.

Tampa

1234

(916) 555-2128

Trey Research

Dana Birkby

2 Nosey Pkwy

Portland

43210

(503) 555-2129

Fourth Coffee

Reshma Patel

Calle Smith 2

Mexico City

56789

(7) 555-2233

ӹӹ To create a find duplicates query
mouse

1. On the Create tab, in the queries group, clickQuery Wizard.
2. In the New Query dialogue box, click Find Duplicates Query Wizard, and then click OK.
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3. If an alert message appears and tells you that the feature is not installed, click Yes to install the wizard.
4. In the list of tables, select the table that contains your duplicate data, and then click Next. Select
TblCustomers.

5. In the list of available fields, select only the field or fields that contain duplicate information.

6. Add only the “Company Name”, “Address” and “City fields”, these are the only fields that contain characterfor-character matching values. Click Next.
•

If the fields that you add in this step do not contain character-for-character matches, the query might not return
any results.

7. In the next list of available fields, select the field or fields that contain the data that you want to inspect or
update, or those that contain data that can help you distinguish duplicate from non-duplicate records. Add
the”“Contact Name” and “Phone fields”, because the data in those fields can help you find the duplicate
values and possibly identify why the values were entered. Click Next.
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8. Name the Query “QryFindduplicatesForCustomers” and then click Finish.

9. Run the query. You will see the following result:

10. When you created the Customers table, you might have noticed more than two duplicate records (the
table contains four). You don’t see the other duplicates because the values in the Address field don’t match
character-for-character. You can modify the query to return values that partially match.
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